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MODÜLÜN ADI Bilgisayarla Modelleme
MODÜLÜN TANIMI Bilgisayarda temel 3 boyutlu katı model komutlarını

kullanmakla ilgili temel bilgi ve becerilerin kazandırıldığı
öğrenme materyalidir.

SÜRE 40/32

ÖN KOŞUL Bilgisayarda Üç Boyutlu Çizim modüllerini başarmış
olmak.

YETERLİK Bilgisayarla katı modelleme yapmak

MODÜLÜN AMACI

Genel Amaç
Okul içi gerekli ortam, okul dışı araştırma

yapabileceği işletmeler, kütüphaneler belirtildiğinde
bilgisayarla modelleme ve perspektif oluşturma standartlara
uygun çalışmalar yapabileceksiniz.
Amaçlar:
 3 boyutlu katı modeller oluşturabileceksiniz.
 Oluşturulan modellerin düzenlemelerini yapabileceksiniz.
 Modelleri resme dönüştürebileceksiniz.

EĞİTİM ÖĞRETİM
ORTAMLARI VE
DONANIMLARI

CAD programlarını çalıştırabilecek kapasitede
bilgisayar donanımı, paket programlar, programlarla ilgili
kitaplar ve dokümanlar, projeksiyon cihazı ve donanımı,
uygun laboratuar ortamı, meslek ile ilgili uygun kuruluşlar.

ÖLÇME VE
DEĞERLENDİRME

Her faaliyet sonrasında o faaliyetle ilgili
değerlendirme soruları ile kendi kendinizi
değerlendireceksiniz.

Öğretmen, modül sonunda size ölçme aracı
(uygulama, soru cevap) uygulayarak modül uygulamaları ile
kazandığınız bilgi ve becerileri ölçerek değerlendirecektir.
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GİRİŞ
Sevgili Öğrenci,

Bu modül sonunda edineceğiniz bilgi ve beceriler ile bilgisayar ortamında 3 boyutlu
düşünmeyi ve bu düşüncenizi gerçekleştirmek için vazgeçilmez olan bilgisayarlı 3 boyutlu
çizimin devamı niteliğindeki bilgisayarda katı modelleme temel bilgi ve becerilerini
edineceksiniz.

Model sonunda göreceksiniz ki bilgisayar ile katı model 3 boyutlu tasarım /
modelleme ve oluşturulan bu modelleri görselleştirme işlemlerinde size büyük kolaylık
sağlayacaktır. Bildiğiniz gibi, bilgisayar ortamında 3B tasarım / modelleme,
uygulamalarınızda büyük hız, zaman, doğruluk ve ekonomi sağlayacaktır.

Bilgisayar ortamında 3B (3 boyutlu) katı model olarak tasarlanmış bir binanın bütün
görünüşleri, kesitleri, perspektifleri hatta binanın bitmiş resimleri bu tasarıdan elde edilebilir.
Bu da size proje ve fikirlerinizi kolayca anlatma / sunma benimsetme olanağı verecektir.

Yukarıda anlatılanları gerçekleştirmek için, bilgisayarda 3 boyutlu katı modellemeye
temel olacak bütün sorularınızın cevabını bu kitapçıkta bulabileceksiniz.

Modülde, normalde çok kapsamlı olan temel katı model komutları basite indirgenerek
ve olabildiğince kısa anlatılmaya çalışılmıştır. Modüldeki uygulamalar adım adım ilerleyerek
sonuçlandırılmıştır.

3B katı model bir bina resmi

GİRİŞ
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ÖĞRENME FAALİYETİ–1

Uygun ortam sağlandığında üç boyutlu temel geometrilerin katı modellerini
oluşturmayı, bu modellere uygulanan operasyonları ve temel düzenlemeleri yapacaksınız.

Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır:

 Bilgisayar ortamında üretilmiş resimleri inceleyip (örneğin gazete ve

dergilerdeki konut ilanlarında yer alan resimleri, çeşitli bürolarda bilgisayarda

üretilmiş resimleri vb.) nasıl yapıldıklarını araştırınız.

 Bilgisayarlı çizim programlarında bir katı model kutunun özelliklerini

araştırınız.

Araştırma işlemleri için bilgisayarlı çizim yapan değişik işletmeler, ilgili ders
kitapları, internet ortamı gerekmektedir.

1. 3 BOYUTLU ÇİZİM VE KATI NESNELER

1.1. Basit Geometrik Katı Model Oluşturma Komutları

Katı modeller kutu, silindir, küre, vb. temel geometrik nesneler ile gelişmiş yöntemler
kullanarak oluşturulur. Katı modeller, yüzey modellerin aksine bir ahşap parçası gibi
(dilimleme, boşluk açma vb.) özellik gösterir. Aşağıda temel geometrik nesnelere ait katı
modeller kısaca anlatılmaktadır. Bu komutlara üst mönüden Draw > Solids ile ulaşılabilir.
Ayrıca aşağıda gösterilen Solids araç çubuğunda yer alan işaretlenmiş araçlarla ulaşılabilir.

Katı model komutlarına yukarıdaki araç çubuğundan ulaşılabileceği gibi yandaki üst
mönü komut listesinden de ulaşılabilir. Her komutu kısa yolu ile kullanmak da mümkündür.
Kısa yollar komutun yanında parantez içinde aşağıdaki gibi verilmiştir:

ÖĞRENME FAALİYETİ–1

ARAŞTIRMA

AMAÇ
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Örnek:

Command: SUBTRACT (SU)

1.1.1. Kutu (BOX)

Dikdörtgen ve kare prizma şeklinde, kutuya benzer, tabanı çalışılan XY düzlemine
paralel, katı modeller oluşturmak için BOX katı model komutu kullanılır. Çizilen kutunun
tabanı XY düzlemine oturur. Komuta üst mönüden Draw > Solids ile ulaşılabilir.

Kutu modelini değişik yöntemlerle oluşturmayı öğrendikten sonra göreceksiniz ki
binanın bir çok elemanını oluşturabilirsiniz. Pencere altı / üstü duvarı, döşemeler, tablalar,
pencereler, kapılar vb. bu kullanım alanlarından bazılarıdır.

Command: BOX 

Specify corner of box or [CEnter] <0,0,0>: Kutunun 1. köşesinin (P1) koordinatı
belirlenir. Burada Center seçeneği ile kutunun ağırlık merkezi belirlenerek, bu merkeze göre
kutu çizimi de yapılabilir. Bu durumda kutunun ağırlık merkezi çalışılan XY düzlemi
üzerindedir.

Specify corner or [Cube/Length]: Kutunun 2. (P2), XY düzlemi üzerinde köşegen
oluşturacak ikinci noktadır. Şeklin köşe koordinatı bu ileti ile belirlenir. Kutunun bu şekilde
uzunluk ve genişliği belirlendikten sonra aşağıdaki ileti ile kutunun yüksekliği belirlenir.

Specify height: Kutunun yüksekliği.

 Kenarları Bilinen Katı Model Kutu Oluşturma

Command: BOX 

Specify corner of box or [CEnter] <0,0,0>: Küp şeklinde kutunun 1. köşesi.

Specify corner or [Cube/Length]: L 

Specify length: Kutunun X ekseni yönündeki uzunluğu,
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Specify width: Kutunun Y ekseni yönündeki genişliği,

Specify height: Kutunun Z ekseni yönündeki yüksekliği.(Şekil 1.1’e bakınız)

 Küp Şeklinde Katı Model Kutu Oluşturulması

Command: BOX 

Specify corner of box or [CEnter] <0,0,0>: Küp şeklinde kutunun 1. köşesi.

Specify corner or [Cube/Length]: C  Küp oluşturma seçimi yapıldı.

Specify length: 50  küp şeklindeki modelin kenar ölçüsü.

Şekil 1.1:Kutu şeklinde katı model

 Köşegeni XY Düzlemi Üzerinde Olan Katı Model Kutu Oluşturma

Bu şekilde bir kutu, genellikle duvarınızı vb. oluşturur. Normal duvarlar dışında
pencere altı ve pencere üstü bölümleri oluşturmak için yine bu şekilde kutu modelden
faydalanılabilir. Bunun için, duvarınızın iki noktadan oluşan köşegenini girip yüksekliğini
vermeniz yeterlidir. (Kutu yüksekliğinin köşegenden yukarı oluşması için pozitif, aşağı
oluşması için negatif değeri taşıması gerekir.) (Şekil 1.2.a’ya bakınız.)

Command: BOX 

Specify corner of box or [CEnter] <0,0,0>: Köşegenin ilk köşesinin seçimi. (P1)

Specify corner or [Cube/Length]: Köşegenin ikinci köşesinin seçimi. (P2)

Specify height: Kutunun yüksekliği.
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 Köşegeni XY Düzleminden Farklı Olan Katı Model Kutu Oluşturma

Bu şekilde bir kutu da genellikle duvarlar vb. oluşturulur. Bunun için duvarınızın iki
noktadan oluşan köşegenini girmeniz yeterlidir. Bu tür girişte yükseklik değeri de
tanımlandığından bu değer sorulmaz (Şekil 1.2.b’ye bakınız).

Command: BOX 

Specify corner of box or [CEnter] <0,0,0>: Köşegenin ilk köşesinin seçimi. (P1)

Specify corner or [Cube/Length]: Köşegenin ikinci köşesinin seçimi. (P2)

Bu durumda yükseklik değeri sorulmaz.

Köşegeni XY düzlemi üzerinde olan kutu Köşegeni XY düzleminden farklı olan kutu

a) b)

Şekil 1.2: İki nokta girilerek oluşturulmuş kutu şeklinde katı model

1.1.2. Küre (SPHERE)

Küre şeklinde katı modeller oluşturmak için, SPHERE komutu kullanılır. Kürenin
ağırlık merkezi çalışılan XY düzlemi üzerindedir.

Command: SPHERE 

Current wire frame density: ISOLINES=8 Dilim sayısı bilgisi.

Specify center of sphere <0,0,0>: Bu ileti ile kürenin ağırlık merkezi belirlenir. Bu
durumda kürenin ikinci alt yarısı XY düzleminin altında kalır.
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Specify radius of sphere or [Diameter]: Merkezi belirlenen kürenin, Diameter ile
çap, Radius ile yarıçap değeri belirlenir. Belirlenen bu değerlere göre katı model çizimi
tamamlanarak komut sona erdirilir.

Şekil 1.3: Küre şeklinde katı model

NOT: Normalde küre dört dilimden oluşur. Bunu artırmak için ISOLINES sistem
değişkenini kullanabilirsiniz.

1.1.3. Silindir (CYLINDER)

Silindir şeklinde katı modeller oluşturmak için CYLINDER komutu kullanılır.
Silindirin tabanı çalışılan XY düzlemine paraleldir. Komut ile dairesel ya da elips kesitli
silindir çizmek mümkündür.

Command: CYLINDER 

Current wire frame density: ISOLINES=10

Specify center point for base of cylinder or [Elliptical] <0,0,0>: Bu ileti ile silindir
tabanını oluşturan çemberin merkezi belirlenir.

Specify radius for base of cylinder or [Diameter]: Burada Radius ile silindirin
yarıçap, Diameter ile çap değeri belirlenir.

Specify height of cylinder or [Center of other end]: Silindirin yüksekliğini
belirlemek için bu ileti kullanılır.

Burada ikinci seçenek görüldüğü gibi, Center of other end seçeneğidir. Bu seçenek
ile silindirin merkezine göre, ikinci merkez nokta belirlenerek XY düzlemine göre konumu
değişik olan silindir çizilebilir.
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Şekil 1.4: Silindir şeklinde katı model

1.1.4. Koni (CONE)

Tabanı çalışılan XY düzlemine paralel, (apex seçeneği hariç) koni şeklinde model
oluşturmak için CONE komutu kullanılır.

Command: CONE 

Current wire frame density: ISOLINES=10

Specify center point for base of cone or [Elliptical] <0,0,0>: Bu ileti ile, koninin
tabanını oluşturan çemberin merkezi belirlenir.

Specify radius for base of cone or [Diameter]: Merkezi belirlenmiş koninin,
tabanını oluşturan çemberin, Radius ile yarıçap, Diameter ile çap değeri belirlenir

Specify height of cone or [Apex]: Koninin yüksekliği bu ileti ile belirlenir. Burada
Apex seçeneği tercih edilirse, çemberin tabanına dik olacak şekilde yeni tepe noktası (P2)
tanımlanır. Bu durumda, koninin tabanı çalışılan XY düzlemine paralel olmaz.

Şekil 1.5: Koni şeklinde katı model
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1.1.5. Kama (WEDGE)

Kama şeklinde katı model oluşturmak için WEDGE komutu kullanılır. Kama, bir kare
veya dikdörtgen prizmanın, köşegenleri doğrultusunda kesilmesi şeklinde oluşur. Kamanın
tabanı çalışılan XY düzlemine paraleldir.

Command: WEDGE 

Specify first corner of wedge or [CEnter] <0,0,0>: Bu ileti, kamanın sol alt
köşesinin (P1) koordinatını belirler. İletideki Center seçeneği tercih edilirse modelin yarısı
çalışılan XY düzlemini altında kalır. Yani modelin ağırlık merkezi esas alınmaz (Kamayı
oluşturan prizmanın ağırlık merkezi esas alınmış olur).

Specify corner or [Cube/Length]: Bu iletiyle kamanın diğer köşe noktası girilir. Ya
da kamanın hangi yöntemle çizileceği belirlenir.

Specify height: Kama yüksekliği.

Eğer diğer seçenekler ile çizim yapılacak ise yukarıda kutu (BOX) çiziminde
anlatımımda kullanılan yöntemler kullanılır.

Şekil 1.6: Kama şeklinde katı model

1.1.6. Halka (TORUS)

Simit veya halka şekline benzer katı model oluşturmak için TORUS komutu kullanılır.
Oluşturulan halka modeli çalışılan XY düzlemine paralel konumdadır. Halkanın merkezi XY
düzlemi üzerinde olduğundan, halkanın yarısı XY düzleminin altındadır.

Command: TORUS 

Current wire frame density: ISOLINES=10

Specify center of torus <0,0,0>: Bu iletiyle halka şeklindeki katı modelin merkezi
belirlenir.

Specify radius of torus or [Diameter]: Halka şeklindeki nesnenin çapı veya yarıçapı
bu ileti ile belirlenir.
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Specify radius of tube or [Diameter]: Halka şeklindeki katı model, tüp benzeri bir
nesneden oluşur. İleti ile, bu tüpün çap veya yarıçap değeri girilir. Bir anlamda bu değer
halkanın kalınlık değerini belirlemiş olur.

Şekil 1.7: Halka şeklinde katı model

1.2. Gelişmiş Katı Model Oluşturma Komutları

Yukarıda anlatılan temel katı model geometrileri, her zaman model ihtiyacını
karşılayamaz. Daha karmaşık nesneler elde etmek için, katı model oluşturma komutlarından
da yararlanmak gerekir. Katı model oluşturmak için PLINE nesnelerden yararlanılır. Pline
nesne kapalı bir alan oluşturmalıdır. Komutlara üst menüden Draw> Solids ile, ya da Solids
araç çubuğunda yer alan ve aşağıda işaretli olan araçlarla ulaşılır.

1.2.1. Profile Yükseklik Vererek Model Oluşturma ( EXTRUDE / Height)

Burada temel amaç, Pline (veya region) nesneye yükseklik kazandırılarak katı model
oluşturmaktır. Çember (circle), elips (elipse), çokgen (polygon), dörtgen (rectang),
rondela.pul (donut) nesnelerine EXTRUDE komutu uygulanabilir. Ayrıca kapalı alan
oluşturan yerler Pline veya Region nesneye dönüştürülerek, komut bu nesnelere
uygulanabilir. Bu yöntemle mimaride kolon, duvar, kapı pencere gibi elemanlar
modellenebilir.
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Şekil 1.8:Yükseltilebilen nesneler ve katı modelleri

Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: EXTRUDE (EXT) 

Current wire frame density: ISOLINES=4, Burası bilgi içindir, herhangi bir değer
girilmez.

Select objects: Yükseltilecek nesnelerin seçimi.

Specify height of extrusion or [Path]: 150, Nesneleri yükseltme değeri.

Specify angle of taper for extrusion <0>: Yükseltilirken nesneye uygulanacak
konikleşme açı değeri.

Şekil 1.9: Dörtgen nesnenin değişik açılarda yükseltilmesi

Yukarıda (Şekil 1.9) görülen dikdörtgene (rectang) uygulanan EXTRUDE komutunda,
konikleşme açısı birincisinde “0”, ikincisinde “30” ve üçüncüsünde “-30” derece olarak
verilmiştir. Görüldüğü üzere, taban esas (dörtgen nesne) boyutu sabit kalıp konikleşme yönü
değişmektedir.
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1.2.2. Profili Yol Üzerinde Kaydırarak Model Oluşturma ( EXTRUDE / Path )

Bir profil nesneyi (nesne kapalı alan oluşturan PLine olmalıdır) bir yol (tercihen PLine
nesne) üzerinde kaydırarak katı model oluşturmayı sağlar. Bu yöntemle kapı kasaları,
merdiven korkulukları, cephe profilleri vb. elemanları modellemek mümkündür. Komutun
işleyişi Şekil 1.10’da bir kapı kasasının modellemesinde verilmiştir.

Command: EXTRUDE (EXT) 

Current wire frame density: ISOLINES=4, Burası bilgi içindir, herhangi bir değer
girilmez.

Select objects: Profil nesnenin (daire içindeki kapı kasası ve pervaz kesitinin)
seçilmesi.

Specify height of extrusion or [Path]: p, profil nesnenin yol üzerinde kaydırılması
seçeneği.

Select extrusion path or [Taper angle]: Yol nesnesinin (kanat çerçevesi) seçilmesi.

Şekil 1.10: Bir kapı kasasının extrude ile modellenmesi

1.2.3. Profili Döndürerek Model Oluşturma (REVOLVE)

Burada temel amaç, dönel eksenli kesitler oluşturan makine parçası, şişe, vazo vb.
nesneleri modellemektir. Mimaride profilli sütunlar, değişik eşyalar, vb. modellenebilir.
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Şekil 1.11: Bir kadeh ve vazonun revolve ile modellenmesi

Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: REVOLVE (REV) 

Current wire frame density: ISOLINES=4, Burası bilgi içindir, herhangi bir değer
girilmez.

Select objects: Döndürülecek profil(ler)in seçimi.

Specify start point for axis of revolution or

define axis by [Object/X (axis)/Y (axis)]: Döndürme ekseninin birinci noktasının
seçimi. (İstenirse, bu durumda X ve Y eksenleri orijin esas alınarak döndürme ekseni
olarak seçilebilir. Ya da bir çizgi vb. eksen olarak seçilebilir. Bunun içinde “Object”
seçiminin yapılması gerekir. Şekil 1.11’deki kadeh modelindeki kesik çizgi gibi.)

Specify endpoint of axis: Döndürme ekseninin ikinci noktasının seçimi.

Specify angle of revolution <360>: Profilin eksen etrafında döndürülme açısı.
(Yukarıda Şekil 1.11’de kadeh modelinde 360, 270 ve 90 derece döndürülerek
oluşturulmuş modeller görülmektedir.)

1.3. Katı Modellere Uygulanan Operasyonlar

Katı modellerin kendilerine özgü işlemler yapabilen çeşitli komutları vardır. Bu
komutlar model(ler)i dilimleme, ara kesitini elde etme, birleştirme vb. operasyonları
gerçekleştirir. Komutlara üst menüden Draw> Solids ile, ya da Solids araç çubuğunda yer
alan ve aşağıda işaretli olan (Slice, Section ve Interference) araçlarla ulaşılır. Komutların bir
kısmına (Union, Subtract, Intersect) da üst mönü Modify > Solid Editing bölümünden
ulaşılır. Bu komutalar aynı zamanda Solid Editing araç çubuğunda da yer alır.



14

Uygulamalara geçmeden önce aşağıdaki uygulama örneğini bilgisayarınızda
oluşturunuz (Modeli daha sonraki işlemlerde de kullanmak üzere bilgisayarınıza “Uygulama
Modeli.1” olarak kaydediniz). Örnekte ölçüleri 200*150*100 ve 100*75*50 birimlik iki kutu
vardır. Büyük kutunun içine küçük kutu şekildeki gibi yerleştirilmiştir. Büyük kutunun içine
aynı zamanda r=25 olan ve yüksekliği 125 birim olan silindir modeli yerleştirilmiştir.

Şekil 1.12: Kutu ve silindirden oluşan uygulama modeli

1.3.1. Modeller Üzerinde Boşluk Açma (SUBTRACT)

Bir grup katı modelden, diğer grup katı modeli kullanarak boşluk oluşturmayı sağlar.
Komut kısa yolu SU’dur. Bina tasarımında boşluk açmak amacı ile birçok yerde
kullanılabilir. Duvarda kapı pencere boşluğu açmak, pencere cam boşluklarını açmak vb.
gibi işlerde kullanılır.

Command: SUBTRACT (SU) 

Select solids and regions to subtract from ..

Select objects: Boşluk açılacak katı model(ler)in seçimi (örnekte büyük kutu modeli).

Select solids and regions to subtract …

Select objects: Boşluk açacak model(ler)in seçimi (örnekte küçük kutu ve silindir
modelleri).Sonuç aşağıda görüldüğü gibi olur. Şekil 1.13 a’da modelin orijinali, b’de
ise son durumu görülmektedir.

a) b)

Şekil 1.13: Subtract komutunun uygulanması
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1.3.2. İki Katının Kesişimini (Ara Kesitini) Elde Etme (INTERFERENCE)

İki veya daha fazla katı modelin birbiri içine geçmiş olması durumunda, bu oluşum bu
modellerin ortak bölgesinde ara kesit oluşur. Örneğin büyük kutu içindeki silindirin kutu
içindeki kalan bölümü, bu iki katının ara kesitini oluşturur. Komut modellerin orijinal
durumunu koruyarak ara kesit oluşturur. Komut kısa yolu INF olarak girilebilir. Şekil 1.14,
b’de kutu içinde görülen küçük silindir aranan ara kesiti oluşturur.

Command: INTERFERE (INF) 

Select first set of solids:

Select objects: Ara kesiti oluşturacak birinci grubu oluşturan modellerin seçimi.

Select second set of solids:

Select objects: Ara kesiti oluşturacak ikinci grubu oluşturan modellerin seçimi.

Comparing 1 solid against 1 solid.

Interfering solids (first set): 1

(second set): 1

Interfering pairs : 1

Create interference solids? [Yes/No] <N>: Y Ara kesiti oluşturmak için evet onayı.

a) b)

Şekil 1.14: Interfere komutunun uygulanması

1.3.3. İki Modelden Kesişim (Ara Kesit) Elde Etme (INTERSECTION)

Bu komut da Interfere gibi ara kesit elde etmek için kullanılır. Ancak burada orijinal
modellerin durumları korunmaz. Komut uygulandıktan sonra, sadece geriye ara kesit kalır.
Diğer bölümler silinir. Komutla ara kesit elde ederken bu durum göz önünde tutulmalıdır.
Komut kısa yolu IN olarak girilebilir.



16

a) b)

c)

Şekil 1.15: Intersection komutunun uygulanması

Yukarıda (Şekil 1.15.a) katı modellerin orijinali, b’de büyük kutu ve küçük kutunun
oluşturduğu arakesit, c’de ise, büyük kutu ve silindirin oluşturduğu arakesit görülmektedir.
Komut uygulandığında aşağıdaki iletiler ekrana gelir:

Command: INTERSECT (IN) 

Select objects: 1 found

Select objects: 1 found, 2 total, seçim tamamlandığında başka bir işlem yapılmadan
komut tamamlanmış olur.

NOT: Birden fazla nesne seçimi yapıldığında aşağıdaki hata mesajı ile hatadan dolayı
nesnelerin silindiği belirtilir.

Null solid created – deleted

1.3.4. Katı Modeli Kesme / Dilimleme (SLICE)

Katı modelleri dilimlemek için SLICE komutu kullanılır. Komut tanımlanmış bir
(sınırlanmamış, ille kesitin içinden geçmesi gerekmeyen) kesme düzlemi ile modeli dilimler.
En basit tanımlanan kesit düzlemi üçgenden oluşmuş kesit düzlemi düşünülebilir. Aşağıda
Şekil 1.16’da içi boyalı üçgen, kesme düzlemini oluşturmaktadır.
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Bina tasarımında nesnelerin fazla kısımlarını kesmek, bir katı nesneyi birden fazla
parçaya bölümlemek vb. işlerde kullanılabilir.

Komut girildiğinde aşağıdaki komut iletisi ekrana gelir:

Command: SLICE (SL) 

Select objects: Dilimlenecek katı model nesnelerin seçimi.

Specify first point on slicing plane by [Object/Zaxis/View/XY/YZ/ZX/3points]

<3points>: Dilimleme için kesme düzlemi seçiminde uygulanacak yöntem varsayılan olarak
üç nokta geçerlidir. Bu durumda üç noktanın birincisi girilir.

Specify second point on plane: Üç noktadan ikincisinin girilmesi.

Specify third point on plane: Üç noktadan sonuncusunun girilmesi. Burada
bulunulan yerden Z ekseni değerini girmek yeterli olur (Örnek: @0,0,1 gibi).

Specify a point on desired side of the plane or [keep Both sides]: Dilimleme
sonrasında kalıcı kısmın tıklanmasını veya B seçimi ile sadece dilimleme işinin
gerçekleşmesini sağlar.

 Diğer Seçenekler Aşağıdaki Gibidir:

3points : Üç noktadan oluşan dilimleme düzlemi oluşturur. Üç nokta girişi yapıldıktan
sonra dilimleme gerçekleşmiş olur.

Object: Dilimleme işlemi için çember, yay, elips, PLine nesnelerden düzlem
oluşturmayı sağlar. Aşağıdaki örnekte çember seçimi yapılmıştır.

Zaxis: İki noktadan oluşan bir Z ekseni ve bu eksene dik dilimleme düzlemi tanımlar.

View: O anki ekran görüntüsüne paralel (monitörün cam düzlemi) dilimleme düzlemi
olarak tanımlar. Düzlem geçeceği yer için bir nokta seçilmesi gerekir.

XY: XY düzlemine paralel kesme düzlemi oluşturmayı sağlar. Düzlemin yeri bir
nokta ile belirlenmelidir.

YZ: YZ düzlemine paralel kesme düzlemi oluşturmayı sağlar. Düzlemin yeri bir nokta
ile belirlenmelidir.

ZX: ZX düzlemine paralel kesme düzlemi oluşturmayı sağlar. Düzlemin yeri bir nokta
ile belirlenmelidir.

NOT: Aşağıda anlatılan SECTION komutu için de aynı yöntemler geçerlidir.
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Şekil 1.16: Üç nokta ile katı modeli dilimleme

a) Orijinal katı model b) Z eksenine göre dilimleme

c) Obje seçimine göre dilimleme d) Ekran görünümüne göre dilimleme
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e) XY düzlemine göre dilimleme f) YZ düzlemine göre dilimleme

g) ZX düzlemine göre dilimleme h) Dilimlemede tıklanan bölümün kalıcı olması

Şekil 1.17: Değişik yöntemler kullanarak katı modeli dilimleme

1.3.5. Katı Modelden Kesit Elde Etme (SECTION)

Bir katı modelden görünüş vb. elde edildiği gibi, istenirse kesit de elde edilebilir.
Bunun için SECTION komutu kullanılır. Komut tanımlanmış bir (sınırlanmamış, ille kesitin
içinden geçmesi gerekmeyen,) kesit düzlemi ile modelin kesitini elde eder. En basit
tanımlanan kesit düzlemi üçgenden oluşmuş kesit düzlemi düşünülebilir. Aşağıda Şekil
1.18’de içi taralı üçgen, kesme düzlemini oluşturur. Mavi dörtgen alan ise kesme düzlemini
daha iyi algılamak için konmuştur.

Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: SECTION (SEC) 

Select objects: Kesiti alınacak katı model nesnelerinin seçimi.

Specify first point on Section plane by [Object/Zaxis/View/XY/YZ/ZX/3points]
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<3points>: Burada varsayılan olarak üç noktanın oluşturduğu kesme düzlemi
tanımlanır. Bu durumda aşağıdaki iletiler ile komut devem eder:

Specify first point on plane: Üçgen düzlemin birinci noktası.

Specify second point on plane: Üçgen düzlemin ikinci noktası.

Specify third point on plane: Üçgen düzlemin üçüncü noktası. Burada bulunulan
yerden Z ekseni değerini girmek yeterli olur (Örnek: @0,0,1 gibi). Bu nokta
girişinden sonra kesit alınmış olur.

Diğer seçenekler yukarıda SLICE komutunda anlatıldığı gibidir.

Şekil 1.18: Intersect komutu ile kesit alma

1.3.6. Modelleri Birleştirme (UNION)

Dilimlenmiş ya da diğer katı model nesneleri birleştirmek / tek parça haline getirmek
için kullanılan komuttur. Burada nesnelerin birbirine dokunma zorunluluğu yoktur. (Yani bu
nesneler gözden ırak olsalar da gönülden birbirine bağlıdırlar). Komut ile parçalanmış ya da
ayrı olan duvar vb. elemanlar, kapılar, pencereler, aynı kaplama dokusu olması istenilen
modeller bu şekilde birleştirilebilirler. Birleştirilen katı modeller bir katmanın özelliklerini
taşır.

Yukarıda SLICE komutu ile dilimlediğiniz nesneleri tekrar UNION komutu ile
birleştiriniz.
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Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: UNION (UNI) 

Select objects: Birleştirilecek nesnelerin seçimi. Seçim tamamlandığında (Enter
tuşuna basılarak) işlem de tamamlanmış olur.

1.3.7. Modele Et Kalınlığı Verme (SHELL)

Bazı katı modellerin içi boşlukludur. Şişe vb. modellerin içleri boştur. Mimaride daha
çok eşya tasarımlarında kullanılabilecek komuttur. Katı modele et kalınlığı kazandırmak için
SHELL komutu kullanılır. Komut doğrudan çalıştırılmayıp SolidEdit (katı modelin
düzenlenmesi) ana komutu altında yer alan seçeneklerden biridir.

Command: SOLIDEDIT

Solids editing automatic checking: SOLIDCHECK=1

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: b katı modele
hangi tür düzenleme yapılacağı. Burada gövdeye uygulanacak düzenleme seçimi
yapılır.

Enter a body editing option

[Imprint/seParate solids/Shell/cLean/Check/Undo/eXit] <eXit>: s gövdeye
uygulanacak düzenleme seçimi yapılır. Burada SHELL seçimi yapıldı.

Select a 3D solid: Katı modelin seçimi yapılır.

Remove faces or [Undo/Add/ALL]: Modelde düzenleme dışı kalacak bölümler
seçilir. Aksi durumda Enter ile geçilir.

Enter the shell Offset distance: Et kalınlığının ölçüsü verilir.

Aşağıdaki kadeh modellinin oluşturulmasındaki işlemler dikkatle takip ediniz.

a) b) c) d) e) f)

Şekil 1.19: Solidedit / Shell komutunun uygulanması
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a : Kadeh modeli için profil hazırlama

b: Revolve ile katı model oluşturma

c: Modelin dolu olarak görüntüsü

d: Modele SHELL komutunun uygulanması (Kenarların çift çizgili oluşuna dikkat
ediniz. Şu anda üst kapağı da olan içi boş kadeh modelimiz oluştu.)

e: Modele SLICE komutunun uygulanması. (Modelin üst kısmı olan kırmızı bölümü
modelden dilimlenerek ayrılmıştır.)

f: Modelin içi boş halde son görüntüsü
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Dosyanızda katman, limits vb. gerekli

hazırlıkları yapınız.

 Binanın dış duvar bölümünü oluşturan bir

kutuyu BOX ile oluşturunuz.

 Diğer üç mahali de oluşturacak kutuları da

yine BOX ile oluşturunuz.

 Kutu yükseklikleri kat yüksekliği

olacağından hepsinin yüksekliğini aynı

veriniz.

 SUBTRACT komutunu uygulayarak,

büyük kutudan diğer üç küçük kutuyu

çıkartarak mahalleri oluşturunuz.

 Aynı şekilde kapı ve pencere boşlukları

için de kutular oluşturarak duvarlarda

boşluk açınız.

 Pencere boyutları vb. fazla olan kısımları

kesmek için SLICE komutu kullanınız.

 Bu işlemleri yaparken komut satırını

kullanmayı tercih ediniz.

 Daha önceden hazırlanmış basit kat

planlarından yararlanarak daha değişik

planların basit katı modellerini

oluşturabilirsiniz.

 Bu bölümde kutu komutunu daha çok

kullanacağınızdan, kutu oluşturma

yöntemlerini tekrar ediniz.

UYGULAMA FAALİYETİ
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Şekil 1.20: Basit bir bina katı modelini oluşturma
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Katı model oluşturma komutları ile temel geometrilerin katı modelleri oluşturulabilir.

2) Temel geometrilerden olan Piramit, Pyramid komutu ile modellenebilir.

3) Kutu (BOX) katı modeli birden fazla yöntemle oluşturulabilir.

4) Bütün katı modellerin tabanı aktif XY düzlemine oturur.

5) Extrude komutu Pline nesnelere sadece yükseklik kazandırarak model oluşturur.

6) Şişe, yuvarlak masa vb. nesneler, Revolve komutu ile modellenirler.

7) Katı modellerin geometri yapısı tutamakları ile değiştirilebilir.

8) Katı modellerde boşluk açılabilir.

9) Katı modellerden arakesitler elde edilebilir.

10) Katı modeller Pedit / Join komutu ile birleştirilirler.

Cevaplarınızı cevap anahtarı ile karşılaştırınız.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B. PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, yaptığınız 3B temel geometrilerin
katı model uygulamalarını değerlendiriniz.

Gerçekleşme düzeyine göre, evet-hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Değerlendirme Ölçütleri

Amaç
3B Katı modeli oluşturmak, temel
düzenlemeleri yapmak.

Adı soyadı

Konu 3B Katı nesneler oluşturmak Sınıf Nu

Gözlenecek Davranışlar Evet Hayır

1 Katı model kavramını öğrendiniz mi?

2 Temel geometrilerin katı modelini oluşturmayı öğrendiniz mi?

3
Pline nesneleri yükselterek katı model oluşturmayı öğrendiniz

mi?

4
Pline nesneleri bir yol üzerinde kaydırarak katı model

oluşturmayı öğrendiniz mi?

5
Pline nesneleri döndürerek katı model oluşturmayı öğrendiniz

mi?

6 Katı modelde boşluk açmayı öğrendiniz mi?

7 Katı modelden arakesit elde etmeyi öğrendiniz mi?

8 Katı modeli dilimlemeyi öğrendiniz mi?

9 Katı modeli birleştirmeyi öğrendiniz mi?

10 Katı modelden kesit almayı öğrendiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksiklerinizi tamamlayınız.
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ÖĞRENME FAALİYETİ - 2

Uygun ortam sağlandığında üç boyutlu katı model düzenlemelerini tanıyıp gerekli
temel ve gelişmiş katı model düzenlemelerini yapabileceksiniz.

Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır:

 Ahşap üretim yapan bölümlerde, ahşap elemanların nasıl işlendiğini yetkili biri

eşliğinde inceleyiniz. Siz de bilgisayar ortamında modellerinize bu tür

uygulamaları yapabilir misiniz? Araştırınız.

 Yukarıdaki araştırmada, ahşap bölümündeki bütün araç gereçlerle ahşabın

istenilen nitelikte ve özellikte işlenebilme durumu var mıdır? Buradaki araç

gereçler de gerekiyor mu? Araştırınız.

Araştırma işlemleri için okulunuzdaki ve çevrenizdeki ahşap / mobilya üreten
bölümler veya işletmeler, ilgili araç gerecin dokümanları ve internet ortamı gerekmektedir.

2. KATI MODEL DÜZENLEME

2.1. Katı Modele Uygulanan Standart Düzenlemeler

Daha önceden üzerinde çalıştığımız Uygulama Modeli . 1 adlı katı modeli
bilgisayarınızdan açınız. Eğer yoksa yeniden oluşturunuz. Aşağıdaki komutları bu örnek
üzerinde uygulayacağız.

2.1.1. Model Kenarlarını Yuvarlatma İşlemi (FILLET)

FILLET komutu bilindiği gibi, doğrultuları ya da kendileri kesişen doğruları
yuvarlatmak (veya köşe yapmak) için kullanılır. Komut katı modellerde kenarları
yuvarlaklaştırmak için kullanılır. Aşağıdaki örnekte mavi ile gösterilen kenarlar
yuvarlaklaştırılmıştır.

Mimaride yuvarlatılması gereken duvar vb. kenarlar ile eşyalarda kullanılabilir.

ÖĞRENME FAALİYETİ–2

ARAŞTIRMA

AMAÇ
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Şekil 2.1: Katı modele Filet komutunun uygulanması

Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: FILLET (F) 

Current settings: Mode = TRIM, Radius = 0.0000

Select first object or [Undo/Polyline/Radius/Trim/Multiple]: Modelde ilk kenarın
seçimi.

Enter fillet radius: 10 Yuvarlatma yarıçap değerinin girilmesi.

Select an edge or [Chain/Radius]: Diğer kenarların seçiminin yapılması.

Select an edge or [Chain/Radius]: Seçim işi bitince Enter tuşuna basılıp işlem
tamamlanır.

9 edge(s) selected for fillet. Toplam 9 kenara işlem yapılmıştır.

NOT: Chain seçimi ile, zincirleme seçilebilen kenarlar seçilir. Radius ile yuvarlatma
değeri bundan sonra seçilecek kenarlar için yeniden belirlenir.

2.1.2. Model Kenarlarına Pah Verme (CHAMFER)

CHAMFER komutu bilindiği gibi doğrultuları ya da kendileri kesişen doğrulara pah
yapmak (veya köşe yapmak) için kullanılır. Komut katı modellerde kenarları pahlandırmak
için kullanılır. Aşağıdaki örnekte mavi ile gösterilen kenarlar pahlandırılmıştır.

Mimaride pahlandırılması gereken duvar vb. kenarlar ile eşyalarda kullanılabilir.

Şekil 2.2: Katı modele Chamfer komutunun uygulanması
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Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: CHAMFER (CHA) 

(TRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:,
modelde kenarlardan birinin seçimi. Bu seçim aynı zamanda bir yüzeyin de seçimini
yapmış olur.

Base surface selection...

Enter surface selection option [Next/OK (current)] <OK>: n gerekirse Next ile
komşu yüzey seçimi yapılır.

Enter surface selection option [Next/OK (current)] <OK>:

Specify base surface chamfer distance <10.0000>: Chamfer birinci ölçü değeri.

Specify other surface chamfer distance <10.0000>: Chamfer ikinci ölçü değeri.

Select an edge or [Loop]: Yüzeyleri belirlenen modelde kenarların seçimi yapılır.

Select an edge or [Loop]: Seçim işi bitince Enter tuşuna basılıp işlem tamamlanır.

NOT: Loop ile seçili yüzeylerin, kenarlarının hepsinin seçilmesi sağlanır.

2.1.3. 3 Boyutlu Çoğaltma (3DARRAY)

Bilindiği üzere ARRAY komutu 2B çizimlerde nesneleri çoğaltmak için kullanılır.
Komut tıpkı Array komutu gibidir. Farklı olarak, çoğaltma işlemini Z ekseni yönünde de
yapabilmesidir. 3DArray komut katı modellere özgü komut olmayıp bütün 3B çalışmalarda
kullanılır.

Komut çalıştırıldığında aşağıdaki iletiler ile devam eder.

Command: 3DARRAY 

Select objects: Çoğaltılacak nesne(lerin) seçimi (Şekilde pembe renkteki model)

Enter the type of array [Rectangular/Polar] <R>: Çoğaltma yönteminin seçimi.
Burada <R> ile dörtgensel yöntem seçilmiştir.

Enter the number of rows (...) <1>: 3 Çoğaltmada satır sayısı (X eksenine paralel)

Enter the number of columns (|||) <1>: 4 Çoğaltmada sütun sayısı (Y eksenine
paralel)
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Enter the number of levels (...) <1>: 2 Çoğaltmada kat sayısı (Z eksenine paralel)

Specify the distance between rows (...): 250 Satırlar arası mesafe

Specify the distance between columns (|||): 350 Sütunlar arası mesafe

Specify the distance between levels (...): 130 Katlar arası mesafe

Şekil 2.3: 3DArray ile bir modeli dörtgensel çoğaltma

Polar (dairesel) çoğaltmada yöntem, 2B Array’da olduğu gibidir. Z ekseni yönüne
henüz çoğaltma yapılamamaktadır. Ancak çoğaltma ekseni yönünü belirlemek olanaklıdır.

2.1.4. Simetri Elde Etme / Aynalama (MIRROR3D)

Nesnelerin simetrisini elde etmek için bilindiği gibi MIRROR komutu
kullanılmaktadır. Komut 2B çizimlerde nesnenin sadece XY düzlemi üzerinde simetrisini
oluşturur. MIRROR3D komutu ise simetri ekseni yerine “simetri düzlemi” mantığı
kullanarak, nesnelerin 3B ortamda simetrilerini almayı sağlar.

“Öğrenme Faaliyeti 1” bölümünde daha önce anlatılan SLICE ve SECTION
komutlarında uygulanan düzlem oluşturma mantığı burada da geçerlidir.
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Şekil 2.4: Mirror 3D ile bir modelin simetrisini elde etme

Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir:

Command: MIRROR3D 

Select objects: Simetrisi alınacak nesne(ler)in seçimi

Specify first point of mirror plane (3 points) or

[Object/Last/Zaxis/View/XY/YZ/ZX/3points] <3points>: o Simetri oluşturacak
yöntemin belirlenmesi (Burada nesne yöntemi)

Select a circle, arc, or 2D.polyline segment: Burada nesne (şekildeki yeşil renkteki
daire) seçimi yapılır.

Delete source objects? [Yes/No] <N>: Orijinal nesnenin silinip / silinmemesi (burada
silinmiyor).

2.1.5. 3 Boyutlu Döndürme (ROTATE3D)

3B çizimlerde çok kullanılacak 3B komutlardan biri de ROTATE3D komutudur.
Komut seçilen (2B ya da 3B) nesneleri 3B olarak döndürmeye yarar. Komut katı modele
özgü komut değildir. 3B çalışmaların her alanında kullanılabilir. Komut ayrıntılı olarak
Bilgisayarda Üç Boyutlu Çizim modülü Öğrenme Faaliyeti. 5’te anlatılmaktadır.

Aşağıda (Şekil 2.5) iki noktaya göre modelin döndürülmesi gösterilmiştir.
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Şekil 2.5: Rotate3D ile bir modelin döndürülmesi

2.1.6. Ölçeklendirme (SCALE)

Ölçekleme komutu olan SCALE, 3B nesneleri de ölçekleyebilir. Burada da dikkat
edilmesi gerek nokta, ölçekleme işleminin baz alınan noktaya göre yapılacağıdır. Aşağıda
Şekil 2.6’da P1 ve P2 noktasına göre 0.5 ölçeğinde ölçekleştirilmiştir.

Şekil 2.6: Scale ile bir modelin ölçeklendirilmesi

2.1.7. Taşıma (MOVE)

MOVE komutu ile katı modellere uygulanan özel bir işlem yoktur. Normal olarak
nesneyi taşımakta kullanılan komut, katı model ve diğer 3B nesneleri taşımakta da kullanılır.

2.1.8. Kopyalama (COPY)

COPY komutu ile katı modellere uygulanan özel bir işlem yoktur. Normal olarak
nesneyi kopyalamakta kullanılan komut, katı model ve diğer 3B nesneleri kopyalamakta da
kullanılır.

2.2. Gelişmiş Katı Model Düzenleme Komutları

Katı modellerin düzenlenmesi için kendine özgü komutları vardır. Bu komutlar
SolidEdit (burada komutun yazılış şekli önemli değildir) ana komutu içinde yer alır. Bu
komutlar 3B yüzey modellere uygulanamaz. Komutlara üst menüden Modify> SolidEditing
ile ulaşılabilir. Ayrıca aşağıda görülen SolidEdit araç çubuğu ile de komutlara ulaşmak
mümkündür.



33

SolidEdit komutu kendi içinde
kategorize edilmiştir. Bir katı model kenar
(edge) düzeyinde, yüzey (face) düzeyinde
ve gövde (body) düzeyinde düzenlenebilir.

Düzenleme yapmak için kenarlar
seçilecek ise ilgili kenarların seçim tuşu ile
seçilmesi yeterlidir. Yüzeyler seçilirken de
yüzeylerin üzerini tıklamak yeterli
olmaktadır.

Yanlışlıkla veya istemeden seçilen
kenar ve yüzeyler Remove ile geri
alınabilir.

Şekil 2.7: SolidEdit araç çubuğu ve üst mönüsü

Komut çalıştırıldığında aşağıdaki iletiler ile devam eder:

Command: SOLIDEDIT 

Solids editing automatic checking: SOLIDCHECK=1

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:

Yukarıdaki ana ileti ile hangi düzeyde düzenleme yapılacağı belirlenir. Aşağıda bu
düzeylerle ilgili bilgileri bulabilirsiniz.

2.2.1. Modeli Kenar Düzeyinde Düzenleme

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:

Yukarıdaki iletide E (Edge) seçimi ile komut aşağıdaki şekilde devam eder.

Enter an edge editing option [Copy/coLor/Undo/eXit] <eXit>:
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Bu iletide, önce kenar düzeyinde hangi düzenlemenin yapılacağı belirlenmelidir.
Kenar düzenlemede aşağıdaki seçenekler vardır:

Copy:

Katı modelin kenarlarının kopyasının elde edilmesini sağlar. Komut aşağıdaki şekilde
devam eder.

Select edges or [Undo/Remove]: Kopyalanacak kenarların seçimi. Yanlış veya hatalı
seçilen kenarlar “Remove” ile geri alınır. Seçili kenarlar kesik parlatılmış çizgilerle
gösterilir.

Specify a base point or displacement: Kopyalama için baz alınacak nokta belirlenir.

Specify a second point of displacement: Kopyalamanın nereye yapılacağı belirlenir.

Diğer seçeneklerde hemen hemen benzer şekilde
işler. Yandaki şekilde, bir katı modelin kenarları
kopyalanması anlatılmaktadır. Burada mavi ile belirtilen
kenarlar kopyalanmıştır. Normalde seçili kenarlar kesik
çizgi ile gösterilir. Mavi çizgiler mizansen için konulmuştur.

Kırmızı çizgiler ise kopyalanmış nesnelerdir. Bu
nesneler “Line” olarak ve aktif katman özelliği gösterir.

Şekil 2.8: SolidEdit / Edge /Copy uygulaması

coLor:

Katı modellerin kenarlarının renginin değiştirilmesini sağlar. Komut seçimde kısa yol
olarak L harfini girmek yeterlidir.

Komut seçimi yapıldıktan sonra aşağıdaki iletilerle devam eder:

Enter an edge editing option [Copy/coLor/Undo/eXit] <eXit>: L Kenar rengini
değiştirme seçimi yapılır.

Select edges or [Undo/Remove]: Kenar rengi değişecek, modeldeki kenarlar seçilir.

New color [Truecolor/Colorbook] <BYLAYER>: 1 Kenarların alacağı rengin kodu
girilir.
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Şekil 2.9: SolidEdit / Edge/ color Uygulaması

Undo:

Yukarıda anlatılan komutların uygulanmış işlemlerini geri alır.

eXit:

İlgili komut satırının sonlandırılmasını / bu satırdan çıkılmasını sağlar.

2.2.2. Modeli Yüzey Düzeyinde Düzenleme

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:

Yukarıdaki iletide F (face) seçimi ile aşağıdaki iletiler ekrana gelir.

[Extrude/Move/Rotate/ fset/Taper/Delete/Copy/coLor/Undo/eXit] <eXit>:

Bu iletide, önce yüzey düzeyinde hangi düzenlemenin yapılacağı belirlenmelidir.
Yüzey düzenlemede aşağıdaki seçenekler vardır:

Extrude:

Katı modelin yüzeylerinin, aynı Pline nesneleri Extrude komutu ile yükseltme
işlemine benzer şekilde yükseltir.

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Şekilde
işaretli bölümdeki alan seçimi yapılmıştır.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alma / bütün
yüzeyi seçme)

Specify height of extrusion or [Path]: Yüzeyi yükseltme değeri. Şekilde köşeden P1
noktasına kadar seçili yüzey yükseltilmiştir.
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Specify angle of taper for extrusion <0>: Enter (gerekirse yükseltilen yüzeyin
konikleşme açısı)

Şekil 2.10: SolidEdit / Face / Extrude uygulaması

Move:

Katı modelin tamamen içerisinde kalmış boşlukları model içinde uygun yerlere
taşımak için kullanılır. Aynı zamanda yüzeyleri de taşımak mümkündür. Komut girildiğinde
aşağıdaki iletilerle devam eder.

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Örnekte
dairesel boşluğun (yüzeyinin) seçimi.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alma / bütün
yüzeyi seçme)

Specify a base point or displacement: Yüzeyin taşınmasında esas alınacak noktanın
belirlenmesi. Şekilde dairenin merkezi.

Specify a second point of displacement: Yüzeyin taşınacağı nokta. Şekilde P1 ile
gösterilen bölge.

Şekil 2.11: SolidEdit / Face / Move uygulaması
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Rotate:

Katı model yüzeylerinin, belirlenen bir eksende döndürülerek modelin yüzey
açılarının değişimini sağlar. Böylece model geometrisinde istenilen değişiklikler yapılabilir.
Aşağıda P1.P2 ekseninde ve P3. P4 ekseninde ilgili yüzeyler döndürülmüştür.

Şekil 2.12.a’da orijinal katı model, b’de P1.P2 eksenindeki yüzey, c’de P3.P4
eksenindeki yüzey ve d’de silindir şeklindeki boşluğa ait yüzeyin (dolayısıyla boşluğun),
silindir alt merkezinden X yönüne doğru olan döndürme ekseni ile döndürüldüğü
görülmektedir.

Komut çalıştırıldığında aşağıdaki şekilde devam eder:

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Örnekte
döndürülen yüzey(ler)in seçimi.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alma / bütün
yüzeyi seçme)

Specify an axis point or [Axis by object/View/Xaxis/Yaxis/Zaxis] <2points>:
Döndürme için eksen belirleme yönteminin belirlenmesi. Varsayılan olarak iki noktanın
girilmesi istenir. İki noktadan birincisinin girilmesi istenir.

Specify the second point on the rotation axis: İkinci noktanın girilmesi istenir.

Specify a rotation angle or [Reference]: 20 Döndürme açı değeri girilir.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.

a) b)
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c) d)

Şekil 2.12: SolidEdit / Face / Rotate uygulaması

Offset:

Katı model yüzeyinin ötelenerek model yüzeyinde gerekli değişimlerin yapılmasını
sağlar. Yüzeyler Offset ile kendilerine dik bir eksen üzerinde ötelenebilir. Örnekteki düşey
yüzeyin, P1 noktasından P2 noktasına ötelendiği görülmektedir. Ayrıca Offset ile yüzeylerde
genişletme / daraltma işlemleri de yapılabilir. Örnekte silindir boşluğunun genişlemiş hali
görülmektedir.

Komut girildiğinde aşağıdaki iletiler ile devam eder:

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Örnekte
döndürülen yüzey(ler)in seçimi.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alma / bütün
yüzeyi seçme)

Specify the Offset distance: Offset öteleme mesafesi. Burada girilecek değer
pozitifse genellikle yüzeyde ileri öteleme, negatifse geri öteleme gerçekleşir. Fare ile iki
nokta belirlenerek de mesafe girilebilir. Bu durumda mesafe hep pozitif seçilmiş olur.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.
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Şekil 2.13: SolidEdit /Face / Offset uygulaması

Taper:

Model içinde kalmış boşlukların konikleştirilmesi için kullanılır. Konikleşme için bir
eksen seçilmesi gerekir. Şekil 2.14’te P1 ve P2 noktalarının (silindir alt ve üst kapaklarının
merkezlerinin) oluşturduğu eksen ve 15 derecelik açı ile konikleşme sağlanmıştır. Komut
girildiğinde aşağıdaki iletiler ile devam eder:

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Örnekte
silindir boşluğunu oluşturan yüzeyin seçimi.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alma / bütün
yüzeyi seçme)

Specify the base point: Eksen için birinci noktanın seçimi.

Specify another point along the axis of tapering: Eksen için ikinci noktanın seçimi.

Specify the taper angle: 15 Konikleşme açı değeri.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.

Şekil 2.14: SolidEdit /Face / Taper uygulaması
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Delete:

Model içinde kalmış boşlukların silinmesi için kullanılır.

Komut girildiğinde aşağıdaki iletiler ile devam eder.

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Örnekte
silindir boşluğunu oluşturan yüzeyin seçimi.

Select faces or [Undo/Remove/ALL]: Enter (Gerekirse seçimi geri alma / bütün
yüzeyi seçme)

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.

Şekil 2.15: SolidEdit /Face / Delete uygulaması

Copy:

Katı modelde yüzeylerin kopyalanarak, aktif haldeki katmanın özelliğini taşıyan
REGION nesne elde edilmesini sağlar. Bu nesneye normal Extrude komutu uygulanarak
yeni katı model nesneler oluşturulabilir.

Komut girildiğinde aşağıdaki iletiler ile devam eder:

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır. Örnekte
üst yüzey ile ön yüzey seçilmiştir.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alama / bütün
yüzeyi seçme)

Specify a base point or displacement: Kopyalamada baz alınacak noktanın seçimi

Specify a second point of displacement: Kopyalama yerinin belirlenmesi.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.
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Şekil 2.16: SolidEdit / Face / Copy uygulaması

coLor:

Katı modelleri gerçek resimlere dönüştürürken doku ataması yapılması gerekir.
Örneğin bir bina duvarında modelin (duvarın) iç ve dış tarafı aynı özellikte olduğundan,
atanan doku hem binanın içi hem de dışına atanmış olur. Bu da istenmeyen bir durumdur.
Bunun için duvarın doku atamaları için farklı renklerde olması istenir. Color komutu bize bu
olanağı verir.

Komut girildiğinde aşağıdaki iletiler ile devam eder:

Select faces or [Undo/Remove]: Model üzerinde yüzey(ler)in seçimi yapılır.

Select faces or [Undo/Remove/ALL]: Enter (gerekirse seçimi geri alma / bütün
yüzeyi seçme)

New color [Truecolor/COlorbook] <BYLAYER>: 1 Rengi değişecek yüzey için
renk kodunun girilmesi. (Kırımızı renk için, 1 kodu gibi.)

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.
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Şekil 2.17: SolidEdit / Face / Color uygulaması

Undo:

Yukarıda anlatılan komutların uygulamasını geri alır. Örneğin Solidedit / face /
extrude ile yüzeyi yükseltip, ilgili komut satırına gelindiğinde, Undo ile Extrude işlemi geri
alınmış olur.

eXit:

SolidEdit / Face modundan çıkılır. Bir üst seviye olan SolidEdit seviyesine geçilir.

2.2.3. Modeli Gövde Düzeyinde Düzenleme

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>:

Yukarıdaki iletide B (Body) seçimi ile aşağıdaki iletiler ekrana gelir.

[Imprint/seParate solids/Shell/cLean/Check/Undo/eXit] <eXit>:

Bu iletide, önce gövde düzeyinde hangi düzenlemenin yapılacağı belirlenmelidir.
Gövde düzenlemede aşağıdaki seçenekler vardır:

Imprint:

Katı modele bazen 2B nesneler ekleyerek model üzerinde geliştirme / değişiklik
yapılabilir. 2B nesneler Imprint komutu ile modele eklenirler. Line, Rectang, Circle vb.
nesneler imprint olarak eklenebilir. Aşağıdaki şekilde bir çizgi ve bir dörtgen nesne katı
modele eklenmiş ve Extrude komutu uygulanmıştır.

Komut girildiğinde aşağıdaki iletiler ile devam eder:

Select a 3D solid: Ekleme yapılacak katı modelin seçilmesi.

Select an object to imprint: Katı modele eklenecek 2B nesnenin (örnekte dörtgenin
seçilmesi).
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Delete the source object [Yes/No] <N>: y Seçilen nesnenin modele ekleneceğinin
onayı.

Burada ilk nesne eklenir. İkinci nesne (örneğin çizgi için) tekrar çizginin seçilip
onayının alınması gerekmektedir. Aynı zamanda nesnelerin model yüzeyleri dışında
olmaması gerekir.

NOT: İmprint nesne ile model yüzeyinde ek yüzeyler de elde edilir. Bu yüzeylere Face
/ Extrude vb. komut uygulandığında diğer imprint nesneler modelden kaldırılırlar. Şekil
2.18’ de örnek uygulama gösterilmiştir.

Şekil 2.18: SolidEdit / Body / Imprint uygulaması

cLean:

Yukarıda anlatılan “Imprint” komutu ile eklenen nesneleri silmek için kullanılır.
Aşağıda Şekil 2.19’da katı modele nesneye iki adet imprint nesne görülmektedir. Katı
modele uygulanan Body / Celan ile bir anlamda modeldeki bütün imprint nesneler
temizlenmiş olur.

Komut girildiğinde aşağıdaki iletiler ile devam eder:
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Select a 3D solid: Ipmrint nesnelerin eklendiği katı modelin seçilmesi. Bu durumda
modeldeki bütün “imprint” nesneler silinmiş olur.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.

Şekil 2.19: SolidEdit / Body / Clean uygulaması

seParate solids:

Bir katı model nesne Subtract komutu ile boşluk açılarak; ya da ayrı yerlerde olan katı
model nesneler Union ile birleştirilmiş ise (hani gözden ırak olsalar da gönülleri bir
demiştik) işte bu nesneleri birbirinden ayırmak için Separate solids komutu kullanılır.

Aşağıda Şekil 2.20.a’da modelin ortasına bir kutu konulduğu, b’de bu kutunun
“Subtract” komutu ile ana modelde boşluk açtığı görülmektedir. Ana model bu durumda
ikiye ayrılmış olur. Ancak tek bir nesne gibi davranır. Şekil 2.20.c’de ise bu durumdaki
modele Separate solids komutu uygulanarak, modelin sağ parçasının Move ile taşındığı
görülmektedir.

Komut girildiğinde aşağıdaki iletiler ile devam eder:

Select a 3D solid: Ayrılması istenen, birleştirilmiş haldeki modelin seçilmesi istenir.
Seçim yapıldığında işlem tamamlanmış olur.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.

a) b) c)

Şekil 2.20: SolidEdit / Body / Separate uygulaması
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Shell:

Katı modele et kalınlığı vermek için kullanılan komuttur. Modelin dış ve iç
yüzeylerini öteleyerek (bir anlamda Offset ederek) model yüzeyinin kalınlaştırılmasını
sağlar. Şekil 2.21’de modele 5 birimlik kalınlık verilmiş ve içinin görüntülenmesi için
dilimlenmiştir.

Şekil 2.21 a’da modele uygulanmış et kalınlığı, b ve c’de dilimlenen modeli ikiye
ayırarak iç görüntüsüne yer verilmiştir.

Komut girildiğinde aşağıdaki iletiler ile devam eder:

Select a 3D solid: Komut uygulanacak katı modelin seçilmesi.

Remove faces or [Undo/Add/ALL]: Enter (veya seçilen katı modelde et kalınlığı
verilemeyecek yüzeylerin geri alınması / eklenmesi).

Enter the shell Offset distance: 5 Et kalınlığı.

Komut istenirse gelecek iletilerdeki eXit seçimi sonlandırılabilir. Ya da düzenleme
işlemine devam edilebilir.

a) b)

c)

Şekil 2.21: SolidEdit / body / shell uygulaması

Check:

Katı modele uygulanacak komutlar için, modelin test edilmesini sağlar.
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Undo:

Yukarıda anlatılan komutların uygulamasını geri alır. Örneğin Solidedit / Body / Shell
ile yüzeye et kalınlığı verilmiş ise komut satırına gelindiğinde, Undo ile Shll işlemi geri
alınmış olur.

eXit:

SolidEdit / Body modundan çıkılır. Bir üst seviye olan SolidEdit seviyesine geçilir.

2.3. Model Oluşturma Uygulamaları – Küçük Bir Konutta 3B
Uygulama

2.3.1. Hazırlık Çalışmaları

Herhangi bir proje üzerinde çalışırken, daha önceden hazırlık yapılması gerekir.
Projenin bir tasarısını / eskizini oluşturunuz. Daha sonra bilgisayar ortamında katman, çizgi
tipi, sınırlar, ölçü ve yazı stilleri, tefriş elemanlarının sağlanması vb. gibi ön hazırlıkları
tamamlayınız. Dosyanızı bilgisayarınıza “3B Konut Uygulaması” adı altında kaydediniz.
Çünkü bundan sonra bütün çalışmalar bu uygulama üzerinde gerçekleştirilecektir.
Çalışmalarınızın kaybolmaması için sık sık kaydetmeyi unutmayınız. Gerekirse yedek
almayı ihmal etmeyiniz.

Şekil 2.22: Uygulamada kullanılacak katmanlardan bazıları

2.3.2. Duvarların Oluşturulması

Duvarları oluşturmak için 2B olarak duvarları sıvasız halde çiziniz (daha önceden
hazırlanmış projelerde katmalardan yararlanarak sadece duvar katmanını aktif
yapabilirsiniz). Duvarları çizerken her bir duvar bölümünün kapalı alan oluşturmasına dikkat
ediniz.
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Ekranı çok pencereli hale getirerek, uygulamakta olduğunuz işlemleri daha iyi
algılayacağınızı unutmayınız.

Duvarlarda her bir kapalı alan oluşturan duvar bölümünü “Pline” nesne haline
getiriniz. Bunun için PEDIT ya da BOUNDARY komutlarını kullanabilirsiniz.(Şekil 2.23’e
bakınız)

Binanın dış çerçevesinden yararlanarak, ileride döşeme, çatı ve su basmanı
oluşturacak Pline nesne oluşturunuz.

Bu duvar bölümlerini EXTRUDE komutu ile kat yüksekliği (örneğin 272 cm) kadar
yükseltiniz (Şekil 2.24.a,b,c,d’ye bakınız).
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Şekil 2.23: Uygulamada kullanılacak katmanlar

a) Yükseltilmiş duvarlar b) BOX ile oluşturulan pencere altı duvarları

c) d)

Şekil 2.24: Duvarlar ve pencere-kapı boşluklarının oluşturulması
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2.3.3. Duvarda Boşluk Oluşturmak

BOX komutunu kullanarak pencere alt ve üstündeki duvarları oluşturunuz. Üst
duvarları oluştururken BOX yüksekliğini negatif vermeyi unutmayınız. Bu şekilde
duvarlarda pencere boşluğu açılabilir. Ancak duvar içine kutu vb. konularak SUBTRACT
komutu ile de boşluk açılabilir. Sonradan gerekli olan duvarları UNION komutu ile
birleştiriniz.

2.3.4. Pencere Oluşturmak

Pencereleri oluşturmak için, binanın hangi cephesinde çalışıyorsanız UCS’yi
kullanarak bu cephede kullanıcı koordinat sistemi oluşturunuz. Bu koordinat sistemini
kullanarak kapı ve pencereleri oluşturunuz. Pencere oluşturmak için BOX ve EXTRUDE
komutlarını kullanabilirsiniz. (Pencere çerçevesi oluşturup bu çerçevelerden yararlanarak
BOX ile kasa ve kanat oluşturabilirsiniz.)Yine cam ve denizlik çizimi için BOX komutu
kullanmak mümkündür. Ayrıca çalışma esnasında kullanılmayan katmanların kapatılması,
size hızlı çalışma ortamı sunacaktır (Şekil 2.25.a,b,c,d’ye bakınız).

a) b)

c) d)

Şekil 2.25: Duvarda pencere oluşturmak
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2.3.5. Kapı Oluşturmak

Önce kapı kanadı yüzüne paralel UCS oluştunuz. Sonra kapı kenarlarına Pline çerçeve
çiziniz. Kapı modeli için “Extrude” komutu iyi bir çözümdür. EXTRUDE komutunda 2B
çizilmiş kasa ve pervazı profil olarak, çerçeveyi de yol (path) olarak kullanabilirsiniz.

Pencere çiziminde olduğu gibi gereksiz katmanların (hatta duvar katmanının)
kapatılması çalışmanızı hızlandıracaktır. Aşağıda Şekil 2.26’da bir kapı modelinin
oluşturulma aşamaları görülmektedir. Şekil 2.27’de de binanın kapı ve pencerelerinin
tamamlanmış hali görülmektedir.

a) b) c)

Şekil 2.26: Duvarda kapı oluşturmak

a) b)

Şekil 2.27: Duvarda kapı ve pencere oluşturmak

2.3.6. Merdiven Oluşturmak

Merdiven modeli oluşturmada da yine 2B merdiven çiziminden yararlanmak daha
akıllıca olabilir. Önce 2B_merdiven katmanını açınız. Sonra UCS komutu ile merdivenin
katı modelini oluşturacak şekilde kullanıcı koordinat sistemi oluşturunuz. Bu UCS’de XY
düzlemi merdivenin (Pline olan) kesit kısmını, Z yönü ise bu Pline nesnenin yükseltilme
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yönünü belirlemelidir. Şekil 2.28’deki kırmızı çember içine alınmış ikonu dikkatli
inceleyiniz.

Yukarıda anlatılan işlemleri yaptıktan sonra, Şekil 2.28.a’da mavi çizgilerle
gösterilmiş profili EXTRUDE komutu ile yükselterek (bu durumda yükseltme mesafesi
merdivenin kol genişliği olacaktır) model işlemini tamamlayınız.

a) b)

Şekil 2.28: Merdiven modeli oluşturmak

2.3.7. Balkon, Su Basman ve Döşeme Oluşturmak

Binanın balkon, su basman ve döşemesini oluşturmak için, bu elemanlara ait kapalı
alan oluşturan Pline nesneler oluşturunuz. Bunu aktif hale getirdiğiniz “3B_Balkon”
katmanını kullanarak, PLine komutu ile balkon ve binanın kenarlarını dolaşarak (aynı
zamanda subasman ve çatı saçağı için) döşeme için kapalı alan oluşturan Pline nesne
oluşturunuz. Daha sonra bu kapalı alanlı Pline nesneleri EXTRUDE ile gerekli yükseklik
değerleri vererek yükseltiniz.

Şekil 2.29: Binanın balkon, su basman ve döşeme modelini oluşturmak

2.3.8. Çatı Oluk Modelini Oluşturma

Çatı oluğunu oluşturmak için çatı saçak kenarlarından Pline nesne oluşturan kapalı
alanlı nesne oluşturunuz. Sonra yine Pline komutu ile (ya da Pedit komutu ile düzenleyerek)
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kapalı alan oluşturan oluk profilini oluşturunuz. Sonra Extrude / Path komutu ile oluk
modelini tamamlayınız.

Şekil 2.30: Çatı oluk modelini oluşturmak

2.3.9. Çatı Modelini Oluşturma

Çatı oluşturmak için Bilgisayarda Üç Boyutlu Çizim modülünde anlatılan 3DFace
vb. bilgileri kullanacaksınız.

Hatırlayacağınız gibi, Line komutuyla saçak köşelerinden birinde X ekseni ile 45
derece, XY düzlemi ile 17 derece açı yapan 100 birimlik çizgi çiziniz. Bu çizgileri saçak
köşelerine Mirror komutu ile çizilmesini sağlayınız. Fillet komutu ile çatı çözümüne uygun
birleştirmeleri yapınız. Tel çerçeve halindeki bu çatı şekline 3DFace komutu ile yüzey
oluşturup çatı işlemini tamamlayınız.

2.3.10. Korkuluk Modelini Oluşturma

Korkuluk modelini oluşturmak için, önce kapalı alan oluşturan parmaklık profilini
çiziniz. Sonra bu profili REVOLVE komutu ile, Z ekseni doğrultusunda kendi etrafında
döndürerek parmaklık modelini oluşturunuz. Bu modeli “Parmaklık” adı altında bloklayınız.
Daha sonra balkon kenarlarında PLine çizgi çizerek, bu Pline çizgi üzerine 30 birim
aralıklarla MEASURE komutunu kullanarak parmaklık blokunu yerleştiriniz. Bir profil daha
oluşturarak, EXTRUDE ile korkuluk tırabzan kısmını oluşturunuz.

Şekil 2.31: Binanın balkon korkuluk modelini oluşturmak
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a)

b)

Şekil 2.32: Bina modelinin bitmiş hali
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2.3.11. Bina Tefriş Elemanlarının Yerleştirilmesi

Bina içi tefrişinde kullanmak üzere 3B tefriş elemanlarını yerleştiriniz. Bu tefriş
elemanlarını büyük firmaların sağladığı kaynaklardan ve internet ortamından hazır
bulabileceğiniz gibi kendiniz de oluşturabilirsiniz.

2.3.12. Bina Zemininin Modelini Oluşturma

Binanın oturduğu zemini oluşturmak için de Bilgisayarda Üç Boyutlu Çizim
modülünde anlatılan ai_mesh komutunu kullanabilirsiniz. Bahçe duvarlarını Pline nesnede
Extrude komutunu kullanarak oluşturabilirsiniz.

2.3.13. Bina Modelinden Kesit Oluşturma

Bina kesitini elde etmek için Slice komutu kullanılır (buradaki kesit alma işleminde,
nesnelerin gerçekten dilimlendiği unutulmamalıdır). Bina 3B katı model olarak modellendiği
için, modelden temel görünüşler yanında kesiti de elde edilebilir. Aşağıda Şekil 2.33’te
binanın ön görünüşüne paralel kesit düzlemi ile alınmış kesit görülmektedir.

Bina modeline dilimleme işlemi yapmadan nasıl kesit alınacağı da aşağıda “Öğrenme
Faaliyeti .3” bölümünde anlatılmaktadır.

Şekil 2.33: Bina modelinden elde edilmiş kesit
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Dosyanızda katman, limits vb. gerekli
hazırlıkları yapınız.

 Binanın dış duvar bölümünü oluşturan bir
kutuyu BOX ile oluşturunuz.

 Diğer mahalleri de oluşturacak kutuları da
yine BOX ile oluşturunuz.

 Kutu yükseklikleri kat yüksekliği
olacağından hepsinin yüksekliğini aynı
veriniz.

 SUBTRACT komutunu uygulayarak
büyük kutudan diğer üç küçük kutuyu
çıkartarak mahalleri oluşturunuz.

 Aynı şekilde kapı ve pencere boşlukları
için de kutular oluşturarak duvarlarda
boşluk açınız.

 Pencere boyutları vb. fazla olan kısımları
kesmek için SLICE komutu kullanınız.

 Bu işlemleri yaparken komut satırını
kullanmayı tercih ediniz.

 Daha önceden hazırlanmış basit kat
planlarından yararlanarak daha değişik
planların basit katı modellerini
oluşturabilirsiniz.

 Bu bölümde kutu komutunu daha çok
kullanacağınızdan, kutu oluşturma
yöntemlerini tekrar ediniz.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Fillet ve Chamfer komutları sadece 2B nesnelere uygulanabilir.

2) Array komutu 3b nesneleri 3B ortamda çoğaltabilir.

3) Mirror3D komutu 3B ortamda 3B nesnelerin simetrilerini elde eder.

4) Move ve Copy komutları 3B nesneler için özel seçenekler sunar.

5) Solidedit 3B nesneleri kenar, yüzey ve gövde düzeyinde düzenlemek için kullanılır.

6) Solidedit / Edge / Copy ile elde edilen kenarlar PLine özelliği gösterir.

7) Solidedit / Face / Copy ile elde edilen kenarlar PLine / Region nesne özelliği gösterir.

8) Katı model gövdesinde et kalınlığı oluşturmak için, komut satırından “Shell”

komutunu girmek yeterlidir.

9) Katı model yüzeylerine Solidedit komutu ile Extrude (yükseltme) işlemi uygulanabilir.

10) Katı model yüzleri sabit olduğundan döndürülemezler.

11) Katı model nesne tek bir nesne olmasına rağmen, kenar renkleri değiştirilebilir.

12) Komut satırından Offset komutu ile katı model yüzlerini ötelemek mümkündür.

Cevaplarınızı cevap anahtarı ile karşılaştırınız.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B. PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, yaptığınız 3B katı model düzenleme
uygulamalarını değerlendiriniz.

Gerçekleşme düzeyine göre, evet. hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Değerlendirme Ölçütleri

Amaç
3B Katı modelleri standart ve gelişmiş
düzeyde düzenlemek.

Adı soyadı

Konu Katı modelleri düzenleme Sınıf Nu

Gözlenecek Davranışlar Evet Hayır

1 Katı modele Fillet ve Chamfer komutlarını uyguladınız mı?

2 3DArray komutu ile 3B nesneleri çoğaltınız mı?

3 Mirror3D komutu ile 3B nesnelerin simetrisini elde ettiniz mi?

4 Katı model kenarlarından kopya elde ettiniz mi?

5 Katı model kenarlarının renklerini değiştirdiniz mi?

6 Katı model yüzeylerinden kopya elde ettiniz mi?

7 Katı model yüzey renklerini değiştirdiniz mi?

8 Katı modele et kalınlığı verdiniz mi?

9 Katı modelin yüzeylerini döndürdünüz mü?

10 Katı model yüzlerini taşıdınız mı?

11 Katı modele 2B nesne eklediniz mi?

12 Ekleyipte kullanmadığınız 2B nesneyi sildiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksiklerinizi tamamlayınız.
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ÖĞRENME FAALİYETİ -3

Uygun ortam sağlandığında üç boyutlu nesnelerin perspektifini oluşturacak ve
resimlerini elde edebileceksiniz.

Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır:

 Teknik resim kitaplarından perspektif ve çeşitlerini araştırınız.

 Gerçek yaşamda ahşap, doğal taş, cam ve metal malzemelerin hangi temel

özellikleri var araştırınız.

Araştırma işlemleri için malzeme teknik özellikleri vb. bilgilerin yer aldığı kataloglar,
malzeme ile ilgili diğer dokümanlar, internet ortamı, değişik bilgisayarlı çizim programları
gerekmektedir. Bilgisayarlı çizim yapan işletmelerden de ön bilgiler alabilirsiniz.

3. MODELİ RESME DÖNÜŞTÜRME VE
PERSPEKTİF GÖRÜNTÜ

3.1. Görünümler

3.1.1. Standart Görünüşler

Bir model “yüzey model” veya “katı model” olarak oluşturduktan sonra görünüşlerini
elde etmek son derece kolaydır. Görünüşler elde etmek için geniş bilgiyi Bilgisayarda Üç
Boyutlu Çizim modülünde bulabilirsiniz.

Görünüş elde etmek için hatırlayacağınız gibi, üst mönüde View başlığında, 3D Views
listesinde bulunan komutlar kullanılır. Aynı zamanda “View” komutunu ve “View” araç
çubuğunda yer alan komutları da kullanmak mümkündür.

Ayrıca ayrı pencerelerde görünüşler elde etmek için, “Viewports” komutunu
kullanmayı hatırlatmakta yarar vardır.

Aşağıda Şekil 3.1’de Viewpots komutu ile dört görünüm penceresi oluşturularak bu
pencerelere View komutu ile görünüşler yerleştirilmiştir.

ÖĞRENME FAALİYETİ–3

ARAŞTIRMA

AMAÇ
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Şekil 3.1: Bina modelinden temel görünüşler elde etme

3.1.2. Dinamik Görünüşler(Dview)

Oluşturduğunuz 3B modellerinizden daha etkili görünümler elde etmek istiyorsanız,
View komutu yetersiz kalır. Bunun için DVIEW komutu kullanılır. Komut 3B oluşturulmuş
modeller üzerinde etkili dinamik görünüşler elde etmek amacıyla kullanılır.

Şekil 3.2: Bina modelinden perspektif görünüşler elde etme

Aşağıda anlatılan komutların çoğunu 3DORBIT komutu ile gerçekleştirmek
mümkündür. 3DOrbit ile gerçek zamanlı görüntüleme yapıldığında buradaki değerlerin
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büyük kısmının değiştiğini göreceksiniz. Çünkü iki komutta aynı kamerayı ve kamera
bilgilerini kullanır.

Komut girildiğinde aşağıdaki iletiler ekrana gelecektir:

Command: DVIEW 

Select objects or <use DVIEWBLOCK>: all Burada komutun uygulanacağı
nesne(ler) seçilir. Eğer Enter ile geçilirse örnek model gelir. Onun üzerinde işlem
yapılır.

Enter option

[CAmera/TArget/Distance/POints/PAn/Zoom/TWist/CLip/Hide/Off/Undo]:

Burada gerekli komut seçimi yapılarak işleme devam edilir.

TWist: Kamerayı bakış açısı doğrultusunun oluşturduğu eksende döndürür.

Distance: Kamera ve hedef arasındaki bakış doğrultusu uzaklığını belirler. Mesafe
azaldıkça görüntü (gerçek kameralardaki gibi) büyür.

Zoom: Lens (mercek) büyüklüğünü belirler. Bu büyüklük arttıkça görüntüleme açısı
küçülür, azaldıkça büyür. (Şekil 3.3’e bakınız)

POints: Kameranın hedefini ve bulunduğu yeri belirler. (Şekilde kamera yeri bina sağ
alt köşe noktasında, hedef ise bina sağ ön cephe köşesinde dairesel şekilde görülmekte.)

CAmera: Kameranın bulunduğu yerin açısını belirler.

TArget: Kameranın bulunduğu hedefin açısını belirler.

PAn: Görüntüyü ekran düzlemine paralel olarak kaydırır.

CLip: Kesme (kırpma) düzlemi oluşturarak, katı model nesnelerde kesit alma işlemi
yapar.

Off: Perspektifi kapatır.

Undo: Yapılan işlemleri geri alır.

Hide: Bakış doğrultusuna göre geride kalan çizgileri gizler.

Ayrıca burada “CAmera” ile belirlenen yeni değerleri, doğrudan komut satırından
CAMERA komutu ile ayarlamak da mümkündür. Ancak burada kamera yerinin koordinatları
belirlenmiş olur.
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a) Zoom / Lens Len.: 30 b) Zoom / Lens Len.: 30

c) Zoom / Lens Len.: 50 d) Zoom / Lens Len.: 150

Şekil 3.3: Dview / Zoom / Lens Length görünümleri

3.1.3. Uygun Bakış Doğrultusu

Uygun bakış açısını belirlemek için yukarıda anlatılan DVIEW veya 3DORBIT
komutları kullanılabilir. Ancak uygun bakış doğrultusunun seçimi tamamen isteğe bağlıdır.
Çünkü 3B modellenmiş bir binadan yüzlerce bakış doğrultusuna göre görünüş elde edilebilir.

3.1.3.1. Perspektif Görüntü 3 Boyutlu Ortam

Perspektif görünüm elde etmek için Dview / Zoom / Lens ayarlarının yapılması
gerekir. Perspektif görünümü açmak için “3Dorbit” komutundaki “Projection / Perpective”
seçimini yapmak gerekiyor.
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3.1.3.2. Aracın (Kamera) Yatay / Düşey Bakış Açısı

Kameranın yatay ve düşey hareketini, dolayısıyla görüntüsünü Dview / CAmera
ayarları ile yapmak mümkündür.

3.1.3.3. Aracın (Kamera) Odak Uzaklığı

Kamerasının odak uzaklığı, kamera ile hedefin bulunduğu yer olarak algılanırsa odak
uzaklığı bu iki nokta arasındaki mesafedir.

3.1.3.4. Kesit Elde Etme

Kesit (kırpma) düzlemi, kesite bakış doğrultusuna dik hale getirilmelidir. Yani
aşağıdaki kesiti elde etmek için “Ön Görünüş” aktif hale getirilmelidir. Daha sonra
3DORBT komut listesinden More > Adjust Clipping Planes seçimi yapılmalıdır. Burada
kesitin oluşması için ön kırpma düzleminin açık olması gerekir.

Kesit resmi elde edildikten sonra, normal duruma geçmek için kırpma düzlemlerinin
pasif hale getirilmesi gerekir. Bunu yine aynı listeden yapmak olanaklıdır.

Şekil 3.4: 3DORBIT ile kesit alma

3.2. Malzeme Oluşturma ve Atama

Yukarıda anlatılan yöntemlerle 3B görüntüler renkli olarak sunulabilmektedir. Ancak
daha gerçekçi görüntüler elde edebilmek için aşağıda anlatılan işlemlerin de yapılması
gerekmektedir. Bu işlemleri gerçekleştirmek için komut satırından ilgili komutları ile aşağıda
verilen, üst mönü > View > Render ile ulaşılan komut listesi ya da Render araç çubuğundaki
komutlar kullanılabilir (Şekil 3.5’e bakınız)
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Şekil 3.5: Render Materials diyalog kutusu

Malzeme oluşturma atama ve vb. işlemler için RMAT komutu kullanılır. Üst mönüden
de Render > Materials… seçimi yapılır. Komut çalıştırıldığında aşağıda Şekil 3.6’da verilen
“Materials” adlı diyalog kutusunu ekrana getirir.

Diyalog kutusundaki düğmeleri kısaca açıklayacak olursak;

Modifiy: “Materials” alanında listelenmiş malzemelerin düzenlenmesini sağlar.

Duplicate: Seçilen bir malzemenin kopyasını oluşturur.

New: Yeni malzeme oluşturmayı sağlar.

Perview: Seçilen malzemenin yukarısında yer alan pencerede ön izlemesini verir.

Materials Libarrary…: Bilgisayarınızda (programınız ile ilgili) yüklenmiş hazır
malzeme kütüphanesini açar.

Select: 3B nesneye atanmış malzeme bilgisini (adını), “materials” listede gösterir.

Attach: “Materials” alanındaki malzeme listesinden, çizim alanındaki 3B nesnelere
seçilerek malzeme ataması yapar.
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ByACI: Malzeme atama işlemini renge göre yapar.

By Layer: Malzeme atama işlemini katmana göre yapar.

Şekil 3.6: Materials diyalog kutusu
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Şekil 3.7: 3B nesneye katman ile malzeme atanması

3.2.1. Temel Malzemeler

Malzemeler temel olarak dört grupta toplanmıştır. Bunlar; Standard, Marble
(mermer), Granite (granit) ve Wood (ahşap) malzemelerdir. Bu malzeme tiplerini
kullanarak ilgili kategoride çok sayıda malzeme oluşturulması mümkündür.

3.2.2. Hazır Kaplama Malzemeleri

Hazır malzemelere ulaşmak için Materials diyalog kutusunda Materials Library…
düğmesini tıklamak yeterlidir. Bu düğme tıklandığında aşağıdaki Materials Library diyalog
kutusu ekrana gelir.
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Şekil 3.8: Materials Library diyalog kutusu

Diyalog kutusundaki düğmeleri kısaca açıklayacak olursak;

Perview: Seçilen malzemenin yukarısında yer alan pencerede ön izlemesini verir.

<.Import: “Curent Libarary” (sağ taraftaki) listede seçilen malzemeleri, sol taraftaki
aktif çizim listesine aktartır.

Export.>: Aktif çizim listesindeki malzemeyi listeden çıkarır, sağ taraftaki listeye
gönderir.

Delete: Aktif çizim listesinden seçilen malzemeyi siler.

Save: Sağ taraftaki listede olan değişiklikleri dosyaya kaydeder.

SaveAs…: Sağ taraftaki malzeme listesini başka adla (gerekirse başka disk / disket
vb. ortama) kaydetmeyi sağlar.

Open… : Daha önceden kaydedilmiş malzeme dosyasını açar.

Current Drawing alanında yer alan düğmeler ise kısaca şu şekilde açıklanabilir.
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Purge: Bu listede yer alan ancak çizimdeki nesnelere ataması yapılmamış
malzemeleri bu listeden kaldırır.

SaveAs…: Bu listede yer alan malzeme listesini bir dosyaya kaydeder.

3.2.3. Yeni Bir Malzeme Oluşturma

Yeni malzeme oluşturmak için öncelikle RMAT komutunu kullanarak, Materials
diyalog kutusunu ekrana getirmek gerekir. Daha sonra New… düğmesi altında yer alan
listeyi açıp buradan malzeme tipini seçiniz. Sonra New… düğmesini tıklayarak aşağıda yer
alan “New Standard Material” diyalog kutusunu ekrana getiriniz.

Diyalog kutusu temel olarak beş alanda incelenebilir. Bunlardan ilki Attributes olarak
malzemenin “niteliklerini” belirten alandır. İkinci alan Value ile seçili niteliklerin
malzemeye yansıma oranı belirlenir. Color üçüncü alan olup bununla da malzeme
niteliklerindeki renk ayarlamaları yapılır. Malzeme niteliklerine dosyadan resim ataması
yapılacak ise bu durumda aşağıda yer alan dosya işlemleri bölümü olan dördüncü alan
kullanılmalıdır. Son ve beşinci alan ise malzemenin ön izlemesinin yapıldığı Preview
alanıdır.

Adjust Bitmap ise malzeme dokusunun nesnelere kaplanma şeklini ve ölçeğini
düzenler.

Her zaman yeni malzeme yapmak, hem zaman alıcı hem de gereksiz zaman
harcamanıza neden olabilir. Bunu önlemek için birinci yol, oluşturduğunuz yeni malzemeleri
kaydedip saklamanız ve bunları gerektiğinde kullanmanız; ikinci yol ise daha önceki
malzemelerin kopyasını kullanarak ve üzerinde ufak değişiklikler yaparak yeni malzemeler
oluşturmaktır.
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Şekil 3.9: Materials Libarry diyalog kutusu

Malzeme nitelikleri:

Aşağıda sıralanan malzeme nitelikleri, standart bir malzemede yar alan niteliklerdir.
Genellikle bu niteliklerin etkisi, Value değeri arttıkça yükselir. Örneğin burada geçirgenlik
özelliği olan Transparency değeri arttıkça malzeme şeffaflığı da artar.

Color / Pattern: Malzemenin ışık etkisi altında yansıtacağı renk / doku.

Ambient: Malzemenin ışık etkisi olmadan yansıtacağı renk / doku.

Reflection: Malzemenin yansıtıcılık özelliği. Bu özellik ile ayna ve benzeri yansıma
özelliği olan malzemeler oluşturulabilir.

Roughness: Malzemenin pürüzlülük özelliği.

Transparency: Malzemenin geçirgenlik / şeffaflık özelliği.

Refraction: Malzemenin kırılma endeksi

Bump Map: Malzemenin kabarıklık özelliği.
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Yeni Malzeme Oluşturalım:

Örnek bir malzeme için aşağıdaki sırayı izleyebilirsiniz. Biz burada tablo içine
konulacak bir resmi malzeme olarak kullanacağız.

a. RMAT komutunu çalıştırınız.

b. Malzeme türünü belirleyiniz. Burada standart malzeme bize çoğu zaman yeterli
olacaktır.

c. New… düğmesini tıklayınız ve New Standart Material diyalog kutusunu ekrana
getiriniz.

d. Malzemeye (boşluksuz olarak) isim veriniz. Örneğin “Tablo_1” gibi.

e. Color / Pattern için “Find File…” ile hangi ortamdan resim alacaksanız, ilgili
resmi açınız.

f. Yerleşim ayarlarını yapınız.

g. Diğer ayarları da yaptıktan sonra OK ile diyalog kutusunu kapatınız.

Diğer malzeme özelliklerini de kendiniz deneyerek tecrübe edinebilirsiniz. Her an bir
şey keşfettiğinizi göreceksiniz.

3.2.4. Kaplama Ayarları

Eğer malzeme nitelikleri için bir resim dosyası seçilmiş ise ve nesneye yerleşimi
istenilen şekilde değilse bu yerleşimin yeniden düzenlenmesi gerekir. Bunun için, Adjust
Bitmap… düğmesi ile ekrana gelen Adjust Material Bitmap Placement diyalog kutusu
kullanılır. Bununla dokunun nesneye yerleşimi için yatay / düşey ölçeği, kaplanma
seçenekleri vb. ayarlar belirlenir. Buradaki değerlerin ideal ayarları yoktur. Bu, malzeme ve
nesneye bağlı olarak deneme yanılma yoluyla belirlenir.

Tile: Her yüze, kaplamayı döşenmiş olarak yerleştirir.

Crop: Her yüze, kaplamayı bir tek doku parçası olarak yerleştirir.

Fixed Scale: Doku her nesnede aynı büyüklükte kaplanır. Değer artırılınca kaplama
sayısı artar. Tiling alanında Crop seçiminde doku büyüklüğü orantısız gerçekleşebilir.
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Şekil 3.10: Malzemenin nesneye yerleşimi için ayarlar

Fit to Object: Doku her nesnede farklı büyüklükte kaplanır. Bu değer artırılınca
kaplama sayısı artar.

Object Size: Preview penceresinde görüntüyü büyüklüğünü belirler.

Use Auto Axis: Bütün yüzeylere kaplama yapılmasını sağlar.

Maintain Aspect Ratio: Doku ölçek sabitlemesi yapar.

3.2.5. Kaplama Koordinatları Uygulama

Kaplama ayarları her zaman istenilen sonucu vermeyebilir ya da silindirik vb.
nesnelerde kaplama şekli ve değerleri değişmesi gerekebilir. Bu durumda nesneye özgü
malzeme özellikleri belirlememiz gerekir. Bunun için SETUV komutunu kullanmak
gerekmektedir. Aşağıda Şekil 3.11’de görülen kemerli bölümde soldaki resimde, malzemeye
Setuv uygulanmadan önceki hali ve diğerlerinde de sonraki hali görülmektedir.
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Şekil 3.11: 3B Nesneye Setuv komutu uygulaması

3.2.6. Malzeme Konusunda Öğrendiklerimizi 3B Plana Uygulama

Burada dikkat edilecek bir husus var; duvarlarımız iç ve dış yüz olmak üzere iki yüze
sahip. Duvar rengimiz iki yüzde de mavi ve katmanı adı olarak 3B_Duvar”. Yani sizin dış
yüze uygulayacağınız doku aynen iç yüze de uygulanacaktır. Bu da istenmeyen bir
durumdur. Bu gibi durumlarda katı modelin rengini SolidEdit / Face / Color komutu ile
değiştirip renklere farklı malzeme ataması yapmak çözüm getirir.

Yukarıda anlatılan bilgiler doğrultusunda, öğrendiklerimizi daha önceden
hazırladığımız 3B Bina Planına sırasıyla uygulayalım:

a. RMAT komutunu çalıştırınız.

b. Kütüphanedeki sağ listeden malzemeyi seçip, Import düğmesi ile seçilen
malzemeleri sağ taraftaki listeye ekleyiniz (Şekil 3.5’teki malzemeleri seçebilirsiniz).

c. Malzemeleri nesnelere atmak için yukarıda anlatılan metotlardan uygun olanı ile
gerekli atamaları yapınız. Burada önerilen, katman ve renk seçimine göre atama yapmak
olacaktır. Burada atama sol taraftaki Select a Material listesinden “malzemeyi” seçip sağ
taraftaki Select Layer listesinde de layer seçip Attach> düğmesini tıklamanız yeterli
olacaktır. Renk ile ilgili atamada da aynı yöntem uygulayınız.

d. Renk ve katman ile malzeme ataması yapamadığınız nesnelere Attach düğmesi ile
seçerek atama yapınız.

e. Malzeme atamalarının nasıl göründüğünü anlamak için modülün sonunda anlatılan
RENDER komutunu kullanınız.

f. Malzemelerin yerleşimi ve ölçeği konusunda çoğunlukla ilk ayarlar yetersiz kalır.
Bunun için bazı ayarları yapmak gerekebilir. Sonucu ancak Render komutunu kullanarak
görebilirsiniz.

g. Nesnelere atadığınız malzemeleri geri almak için yine Materials diyalog
kutusundaki Detach düğmesini kullanmanız gerekir.
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Malzeme ataması yapılmış haldeki binanın iç görünüşü aşağıda verilmiştir. Resim
diğerlerine göre daha gerçekçi görünmektedir.

Şekil 3.12: Binanın malzeme atamasından sonraki hali

3.3. Çevre Elemanlarını Oluşturma

3.3.1. Lsnew ile Çevre Elemanları

Ağaç, insan, bahçe elemanları vb. çevre elemanlarını ekleyerek modelinizi daha
gerçekçi hale getirebilirsiniz. Çevre elemanlarını hazır olarak program içinde bulabileceğiniz
gibi kendiniz de oluşturabilirsiniz. Çevre elemanı eklemek için LSNEW komutu kullanılır.
Komuta üst mönüden ulaşmak içn, View > Render > Landspace New seçimi yapılır.
Render araç çubuğundan da Landspace new… seçimi yapmak gerekir.

Komut çalıştırıldığında yandaki diyalog kutusu ekrana gelir. Burada soldaki listeden
çevre elemanı, sağdaki pencerede seçilen çevre elemanının ön izlemesi yer alır.



73

Geometri alanında yer alan
seçenekler ile çevre elemanının tek ve
kesişmiş şekilde yerleşimi belirlenir.
Ayrıca aktif düzleme hizalama seçimi de
buradan yapılır.

“Height” ile çevre elamanının
büyüklüğü, “Position<” ile yerleşim yeri
(pozisyonu) belirlenir.

Çevre elemanı düzenlemek için
LSEDIT, yeni çevre elemanı oluşturmak
için LSLIB komutları kullanılmalıdır.
Yeni çevre elemanı için bir resmin orijinali
ve opasite (resim yeri beyaz. boşluklar
siyah) hali kullanılır. Çevre elemanı üçgen
nesne halinde görünür. Render edildiğinde
resme dönüşür.

Şekil 3.13: Landspace new dialog kutusu

Şekil 3.14:Çevre elemanının üçgen nesne ve resim görünümü



74

3.4. Işık Oluşturma

Malzeme ataması yapıldıktan sonra elde edilecek resmin (Render sonucunun) daha
gerçekçi olabilmesi için gerçek dünyadaki gibi nesnelerin aldıkları ışığı yansıtmaları gerekir.
Bu da bir anlamda malzemenin ışık altında görüntülenen hali demektir. Varsayılan olarak,
çizime eğer ışık eklenmemiş ise nesneler her tarafı aydınlatılmış şekilde görülür. Ancak ışık
eklendiğinde ışığın etkisine göre görüntü değişir. Aşağıda binanın ışıksız olarak görüntüsü
verilmiştir.

Şekil 3.15: Binanın malzeme atamasından sonraki ışıksız hali

Çizime ışık eklemek için LIGHT komutu kullanılır. Komuta üst mönü View >
Render > Light… seçimi ile ulaşılır. Render araç çubuğundan da Light komutu ile ulaşmak
mümkündür. Komut girildiğinde aşağıda görülen Light diyalog kutusu ekrana gelir. İşlemler
bu diyalog kutusundan yapılır.

Diyalog kutusu temel olarak iki alandan oluşur. Sağ tarafta Ambient Light alanında
ışıksız render yapıldığında ya da ışık alamayan bölümlerin aydınlatma değerlerini belirleyen
bir adı da “ortam ışığı” olan ışık türü yer alır. Bu ışık gölge oluşturmaz. İkinci alan ise yeni
ışık oluşturma ve düzenleme için ayrılmıştır.

Diyalog kutusunu kısaca açıklayacak olursak;

Ambient Lihgt alanında:

Intensity:
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Ortam ışığının şiddetini belirler. İster sürgülü bölüm kullanılır, isterse sayı değeri
kutucuğuna değeri girilir.

Color:

Ortam ışığının rengini ve seçim şeklini belirler.

Işık Oluşturma / Düzenleme Bölümünde:

New:

Yeni ışık türü oluşturmayı sağlar. Liste açılınca Point Light,
Spot Light, Distant Ligt ışık türlerine ulaşılır. Işıklar oluşturulurken bir
isim verilmesi istenir. Işıkların kontrol edilmesi için, “P_SAĞ_ÖN”
vb. anlamlı isimler vermeyi unutmayınız.

Modify…

Daha önceden oluşturulmuş ışıkların adını, ışık şiddeti vb. özelliklerini yeniden
düzenler.

Delete

Oluşturulmuş ışığı siler.

North Location…

Kuzey yönünün yeniden belirlenmesini sağlar. Özellikle “Distant Light” ışık türünü
etkiler.

Işıklarda Genel Özellikler:

Intensity: Işık şiddetini belirler. Artırıldıkça ışığın nesneleri aydınlatma değeri de
artar.

Shadow: Gölge oluşturmayı sağlar.

Attenuation: Işık şiddeti zayıflama değeri.

Position / Show…: Işığın bulunduğu yerin koordinatlarını görüntüler.

Position / Modify…: Işığın yerinin yeniden düzenlenmesini sağlar.

Color: Işığın renk seçimini yapmayı sağlar.
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Şekil 3.16: Lights diyalog kutusu

3.4.1. Noktasal Işık (Point Light)

Noktasal ışık kaynağı oluşturur. Bu ışık türü ortamdaki her yeri aydınlatabilir. Aşağıda
Şekil 3.17 üst ve alt resimde bina dışındaki ışıklar kapatılıp sadece iç ve girişte kapı
üstündeki noktasal ışık açık tutulmuştur (Gölge seçimi yapılmamıştır).

3.4.2. Spot Işık (Spot Light)

Spot ışık oluşturmayı sağlar. Spot ışıkta da diğer ışıkların özellikleri vardır. Bu
özelliklerin yanında ışık yerleşimi için dikkat edilmesi gereken ışığın hedefi (target) ve
yerini belirleyen aşağıdaki iletiler vardır. Doğru yer ve hedef seçimi yanında ışık şiddeti ve
renk ayarları iyi sonuçlar verir. Aşağıda Şekil 3.18’de uygulama örnekleri verilmiştir.

Enter light target <current>: Işığın aydınlatacağı hedef. Şekil 3.18’de tablonun
çerçeve üst orta yeri.

Enter light location <current>: Işığın yerleştirildiği yer. Şekil 3.18’de tablonun
altında bulunan çiçeğin saksısı üzerinde.

Spot ışık, ışığını bir ışık konisi huzmesi ile yaptığından, gerektiğinde bu ışık koninin
açı değerlerinin ayarlanması gerekir. Bunun için Modify Spotligt diyalog kutusundaki
Hotspot ve falloff ayarlarının yapılması gerekir.
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Şekil 3.17: Binanın malzeme atamasından sonraki ışıklı hali
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Şekil 3.18: SpotLights hedef, yer seçimi ve sonucu
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Şekil 3.19: Modifiy Point Light diyalog kutusu

Şekil 3.20: Modify Spotlight diyalog kutusu
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3.4.3. Güneş Işığı ile Uzak Işık (Distant Light)

Uzaktan gelen ışığı taklit eden, geniş ayar olanaklarına sahip ışık kaynağıdır.
Gerektiğinde yerel tarih ve zamana göre güneş ışığı taklidi yapılabilir. Aşağıdaki resimlerde,
aynı bakış açısı doğrultusunda, noktasal ışıklarla kısmi aydınlatma ve “Türkiye, İstanbul”
yerel konuma göre, 25 Ağustos tarihindeki çeşitli saatlerdeki güneş ışığı etkisi altındaki
görüntüler yer almakta. Aşağıdaki verilen resimleri inceleyiniz.

Resim 3.1: Binanın gece noktasal ışıklarla kısmi aydınlatılması

Resim 3.2: Resim Türkiye, İstanbul 25 Ağustos, Saat: 09:00
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Resim 3.3: Türkiye, İstanbul 25 Ağustos, Saat: 12:00

Resim 3.4: Türkiye, İstanbul 25 Ağustos, Saat: 16:00

Yukarıdaki resimleri inceleyeniz. Özellikle gölgeli kısımlara dikkat ediniz. Bu binanın
arka cephesi kuzey taraftadır. Yerel ayarlar aşağıda Şekil 3.22’de verilen diyalog kutusu ile
Calculator… seçimi yapılır. Burada yer seçimi için önce Modify Distant Light diyalog
kutusundaki Sun Angle Calculator ile gerekli ayarlar yapılır. Burada, modelinizin
çalıştığınız düzlemdeki kuzey yönü ile Solar time ve Clock Time saatlerinin çakışmasına
dikkat etmek gerekir. Eğer yer seçimini diyalog kutusunda yapmak isterseniz Geographic
Lacation düğmesi ile ekrana gelen diyalog kutusundaki gerekli seçimleri yapmalısınız.
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Modelin arka fonunda yer alan bulutlu resimler atmosferi yansıtmak için seçilmiştir. Bunun
için gerekli bilgi aşağıda verilmiştir.

Şekil 3.21: Modify Distant Light diyalog kutusu

Şekil 3.22: Sun Angle Calculator diyalog kutusu
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3.5. Modelden Resim (Render) Görüntü Elde Etme

3.5.1. Render Seçenekleri

Yukarıda görülen resimler, modelin hazırlandıktan sonra malzeme, çevre elemanı, ışık
ile donatılmasından sonra RENDER (RR) komutu ile resim haline dönüştürülmesi
sonucunda elde edilmiştir. Render komutu çalıştırılınca aşağıdaki diyalog kutusu ekrana
gelir.

Şekil 3.23: Render diyalog kutusu

Render İşlemini Şu Sıra İle Yapabilirsiniz:

a. Render Type ile fotogerçekçi render tipi olan Photo Raytrace tipini seçiniz. Diğer
render tipleri iyi sonuç vermeyecektir. Ancak daha hızlı sonuç verirler.

b. Render Options alanında, render seçeneklerini belirleyiniz. Burada malzeme ve
gölgenin render esnasında dikkate alınmasını sağlayacak seçimler vardır. Buradaki
seçimlerin hepsini işaretleyebilirsiniz.
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c. Gerekirse More Options… ile render kalitesini artıracak seçimlerin bulunduğu
diyalog kutusunu açıp buradan gerekli ayarları yapabilirsiniz.

d. Destination alanında, render işleminin sonucunun alınacağı ortamı belirleyiniz.
Burada aktif çalışma penceresi ya da kalıcı olarak bir dosyaya kayıt yapacak şekilde seçim
yapılabilirsiniz.

e. Sub Sampling alanında kaliteli sonuç veren 1:1 (best) seçimini yapınız. Diğer
seçimler hızlı olup kalite yönünden tatmin edici değildir.

f. Render Procedure alanında, yürütülecek olan render prosedürünü belirleyiniz.
Burada seçili nesneleri render etmek, pencere ile seçilen alanı render etmek ve render
diyalog kutusunu atlamak gibi seçenekler yer alır.

g. Işık simgeleriniz çizim içerisinde çok küçük görünüyorsa (simge olarak) Light Icon
Scale ile büyüklüğünü ayarlayabilirsiniz. Bu ışık şiddetini etkilemez.

h. Background… ile ekrana gelen diyalog kutusundan, gerekirse arka fon için resim
seçimi yapınız. (yukarıdaki örneklerde arka fondaki bulutlar bu bölümden eklenmiştir)
Ekrana gelecek diyalog kutusundan Image seçimi yaparak, gerekli dosyanın yerini belirleyip
seçiniz.

Şekil 3.24: Background diyalog kutusu

i. Fog/Depth Cue… ile gerekirse sis etkisi oluşturan seçimi yapınız.
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j. Scene to Render alanından . oluşturulmuş ise – sahne seçimini yapınız.

SCENE komutu ile ekrana gelen sahne seçimi ile, render sırasında modelin ekrandaki
görüntüsü (ön görünüş, perspektif vb.) ve ışıklarının bir arada organize edilmesini /
kullanılmasını sağlar. Görüntü kaydı için daha önceden öğrendiğiniz VIEW komutunu
kullanabilirsiniz.

Şekil 3.25: New Scene diyalog kutusu

k. Oluşan Render resmini gerekiyorsa kalıcı ortamlara kaydediniz. Bunun için
SAVEIMG komutunu kullanabilirsiniz.
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Daha önceden çalıştığınız “3B konut

uygulaması” dosyanızı açınız.

 Dinamik görüntüler için, Dview ve

3Borbit komutunu kullanınız.

 Elde ettiğiniz bu perspektif vb. görüntüleri

View komutu ile kaydediniz.

 Gerekli yeni malzemeleri oluşturunuz.

 Malzemeleri ilgili modellere atayınız.

 Gerekiyorsa ağaç, insan gibi çevre

elemanlarını çizime yerleştiriniz.

 Gerekli aydınlatma araçlarını (ışıkları)

yerleştiriniz.

 Render komutu ile modelden deneme

resimleri oluşturunuz.

 En iyi bulduğunuz resmi kalıcı ortama

kaydediniz.

 Bu işlemleri yaparken (öğrenme

açısından) komut satırını kullanmayı

tercih ediniz.

 Gerektiğinde OSNAP modlarını

kullanınız.

 Render denemeleri yaparken bütün

model yerine modelin kısmı alanlarında

çalınız.

 Render denemelerinde değerleri yavaş

yavaş artırınız. Aksi durumda

bilgisayarınızın donanım performansını

zorlayacağınızı unutmayınız.

 Render sonucunda elde edilen resimleri

kaydetmeyi unutmayınız.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

A. OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Sadece katı model nesnelerin 3B görünüşleri ve perspektifleri elde edilir.

2) Dview komutu ile kamera ayarları yapılabilir.

3) Dview ve 3Dorbit ile modelde kırpma (kesit alma) işlemi yapılabilir.

4) Standart malzeme yanında yeni malzemeler de tanımlamak mümkündür.

5) Malzemeler 3B nesnelere sadece seçilerek atanabilir.

6) Özel geometriye sahip nesnelere malzeme yerleşim koordinatları kontrol edilebilir.

7) Çevre elemanları, modeller gibi 3B nesnelerden oluşmalıdır.

8) Modeli aydınlatmak için gelişmiş ışık türleri kullanılır.

9) Model render resminde gölge oluşturmak için “Shade” komutu kullanılır.

10) Render komutu ile modelden resim görüntüler elde edilir.

11) Render sonucu oluşan resimler kalıcı ortamlara kaydedilebilir.

Cevaplarınızı cevap anahtarı ile karşılaştırınız.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B. PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, yaptığınız 3B koordinat sistemi
uygulamalarını değerlendiriniz.

Gerçekleşme düzeyine göre, evet. hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Değerlendirme Ölçütleri

Amaç
3B modelin görünüş ve perpektiflerini elde
etme. Görüntüleri resme dönüştürme.

Adı soyadı

Konu
Modeli resme dönüştürme ve perspektif

görüntü.
Sınıf Nu.

Gözlenecek Davranışlar Evet Hayır

1 Modelden standart görünüşler elde etmeyi öğrendiniz mi?

2 Modelden dinamik görünüşler elde etmeyi öğrendiniz mi?

3 Yeni malzeme oluşturdunuz mu?

4 Malzemeleri modele atadınız mı?

5 Kaplama ayarlarını yaptınız mı?

6 Çizime çevre elemanları eklediniz mi?

7 Çizime ışık kaynakları eklediniz mi?

8 Sahneler oluşturdunuz mu?

9 Modelin resim görüntülerini elde etmeyi öğrendiniz mi?

10 Resimleri kalıcı ortama kaydetmeyi öğrendiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksiklerinizi tamamlayınız.



89

MODÜL DEĞERLENDİRME

PERFORMANS TESTİ (YETERLİK ÖLÇME)

Modül ile kazandığınız yeterliği aşağıdaki kriterlere göre değerlendiriniz.

PERFORMANS TESTİ
Dersin
adı

İç Mekan Çizimleri Öğrencinin

Amaç
Bilgisayarda modelleme yapma, ve
perspektif resimler elde etme.

Adı soyadı

Konu Bilgisayarda Katı Modelleme Sınıf Nu.
Başlangıç saati

Bitiş saatiZaman

Toplam sure

DEĞERLENDİRME KRİTERLERİ Evet Hayır

3B katı nesneler
A) 3B standart katı nesneleri kavrayıp uyguladınız mı?
B) Gelişmiş katı nesneleri kavrayıp uyguladınız mı?

3B katı model düzenleme
A) Katı modele standart düzenleme yaptınız mı?
B) Katı modele gelişmiş düzenlemeler yaptınız mı?
C) Katı modele operasyon işlemleri yaptınız mı?

3B katı modeli resme dönüştürme ve perspektif görüntü
A)Standart ve dinamik görünüşler oluşturdunuz mu?
B)Standart ve kendi oluşturduğunuz malzemeyi atadınız mı?
C)Çizime çevre elemanları yerleştirdiniz mi?
D)Çizme aydınlatma araçları (ışık) eklediniz mi?
D)Modelden resimler elde ettiniz mi?

Toplam Evet ve Hayır Cevap Sayıları

DEĞERLENDİRME

Yaptığınız değerlendirme sonucunda eksikleriniz varsa öğrenme faaliyetlerini
tekrarlayınız. Kendinizi yeterli görüyorsanız bir sonraki modüle geçmek için öğretmeninize
başvurunuz

Modülü tamamladınız, tebrik ederiz. Öğretmeninizle iletişime geçiniz.

MODÜL DEĞERLENDİRME
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CEVAP ANAHTARLARI

ÖĞRENME FAALİYETİ -1CEVAP ANAHTARI

1 D
2 Y
3 D
4 Y
5 Y
6 D
7 Y
8 D
9 D

10 Y

ÖĞRENME FAALİYETİ- 2 CEVAP ANAHTARI

1 Y
2 Y
3 D
4 Y
5 D
6 Y
7 D
8 Y
9 D

10 Y
11 D
12 Y

ÖĞRENME FAALİYETİ -3 CEVAP ANAHTARI
1 Y
2 D
3 D
4 D
5 Y
6 D
7 Y
8 D
9 Y

10 D
11 D

CEVAP ANAHTARLARI
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